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1. Introduction
Observation: For traceability reasons, the product revision is changed when there is an enhancement in its
functional features or any change of the manufactory process and/or raw material. In the case that the user
cannot find on the following tables the reason of the product revision, it is implicit that there was a change in
the internal manufactory process at Altus and/or hardware, without affects the product
functionality/compatibility.

To update any Altus software contact Altus Support Service.
Telephone numbers an updated contact are available at www.altus.com.br.

2. Nexto Series
2.1 BCS-XP300 – COMPACT PLC 16DI 16DO – BJ
REV




BB





BA

AZ




Description
Support for BCS Tools 3.40.
Fixed a problem where 3G/4G Modem could fail to reconnect after
a communication failure.
Increased the storage capability for the source code, stored now on
a 64MB space that is shared with application and Webvisu files. It
is necessary to reboot the controller without application to make
this new space available. The source code size verification
(warning message) was updated accordingly on BCS Tools 3.40.
Fixed possible issue where the Web Page turns unaccesible after
using it for a very long time.
Fixed the retain system to keep the values after a reboot caused by
an internal software error.
Fixed potential exception when an application is removed (reset
origin).
Minor hardware changes in order to improve the product.
Change of the product label, which now includes a QR Code with
the path to the Technical Documentation of the product on the
website. This change makes it unnecessary to follow the
Installation Guide with the product.
UKCA Certification marking included on product.
Improvement in the production process. Changed RTD settings in
product testing.
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Date(dd/mm/yyyy): 15/12/2022

Minor hardware adjustments to support a new alternative part
number (due to the shortage of electronic components).
Minor hardware adjustments to support a new alternative part
number (due to the shortage of electronic components).
Changes in the source code shared with other products that doesn't
affect this product behavior.
Improved startup stability under specific situations with low power
supply voltage.
New format of firmware update file. This update requires the
controller running on firmware version 1.9.29.0 or greater.
Added protection against CSRF (cross-site request forgery) for
management pages in web interface.
Included login mechanism for operation mode page in web
interface.
Included a new reset mechanism to solve connection failures of
USB modem.
Changed firmware update mechanism to include support for the
new file format that will be introduced on upcoming versions.
Included support for PROFINET Controller.
Included support to CAN J1939.
Included support for “number of connected clients” diagnostic in
status bar. To see this diagnostic, BCS-MT8500 version 3.31 or
greater is required.
Removed the hidden page “getlogs” from the system web page to
improve cyber security.
Change in the product hardware to support minimum operation
temperature of - 20ºC.
Included support for USB WiFi adapters.
Included suppport for additional USB modem devices: Huawei
E3276 and E8372.
Fixed a problem on the PTO fast output that could potentially turn
on the next normal digital output.
Fixed a problem where the digital input value was not updated on
the execution of external interrupt task.
Fixed a problem related to the system webpage cache. This
eliminates the need of clearing the cache on browser side, which
was previously required under some circumstances to show the
page correctly.
Updated the product label for compliance of the UL certification,
File Number E496087.
Included protectors for the product connectors.
Improved performance (CPU clock increased by 85% with
bootloader version 1.0.0.15 included on this version).
Included support to USB modem.
Included support to TLS v1.2 and client certificate in the Function
Block MQTT Client (the last one requires the BCS Tools 3.23 or
greater).
Improved immunity level of RTD inputs against external
electromagnetic interferences.
Fixed a problem that could cause corruption of operating system in
case of engergy interruption during a specific moment of power-up
process, leading the controller to a permanent inoperative state.
Fixed a problem on CANopen Remote I/O mode which could
eventually prevent the controller from starting up.
Fixed a problem that could make the DG LED to blink 4x with no
reason.
Improvements on CANopen Remote I/O mode.
Improvements on serial communication.
Included support for USB Serial RS-232 converter
Included support for the latest version of LibSQLClient library.
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Included support for CANopen Manager (requires BCS Tools 3.19
or greater).
Included support for MQTT Client Function Block (requires BCS
Tools 3.19 or greater).
Fixed the diagnostic tDetailed.Serial.COM1.wRXPendingBytes
which stopped to work on previous version, affecting the Function
Block of Serial communication.
Fixed a situation that could cause a drift of RTC time higher than
the specified.
Included support for CAN termination configuration, introduced
on BCS Tools 3.19.
Included bootloader version 1.0.0.11, which increases the
immunity level against external electromagnetic interferences. The
bootloader is now included inside the firmware image file, and will
be updated automatically during the firmware update process
ONLY if the controller is running with version 1.7.49.0 or greater.
If the firmware update process is performed on a controller with an
installed firmware lower than 1.7.49.0, it is required to perform the
update procedure AGAIN (i.e, twice, to the same version) to have
the bootloader updated.
Included support for Ethernet/IP Scanner.
Included support for I/O expansion through CANopen (CANopen
Slave mode).
Included support for 2400 and 4800 bits/s baudrates on the serial
communication.
Improvements on MODBUS RTU Slave timing, where sporadic
communication errors could occur on a RS-485 network composed
by several slaves.
Changed maximum source code size from 16MB to 26MB
(requires a reboot with no apllication to apply this increase; the
warning message updated on version 3.18 of BCS Tools).
Fixed EasyConnection behavior, where the application was not
being erased after applying the new IP adress, resulting on
returning to the IP address set by the application.
Improved mounting of USB mass storage devices, increasing the
compatiblity with certain models of flash drives.
Fixed maximum number of ARTI/OPC DA connections from 4 to
8.
Fixed generation of counter interrupt.
Replacement for the overlay flat cable connector part number and
change in the insertion procedure.
Included support for new homologated memories
Fixed external input I02, which stopped to work on previous
version.
Improvements on fast inputs and outputs.
Improvements on the USB mass storage mounting system.
Improved EMC immunity level
Included support for OPC UA protocol
Included support for MSSQL_Client Function Block for accessing
Microsoft databases.
Included a fixed DNS Server configuration (8.8.8.8 and 8.8.4.4)
Included support for Fast I/O (counters, external interrupts,
PTO/PWM outputs).
Included support for FAT32 LBA filesystem, used on big capacity
USB mass storage devices.
Fixed a problem on function GetTimeZone, which could cause an
exception leading the CPU to STOP.
Improvements on GetDateAndTime and GetDayOfWeek
functions, which could cause peak on execution time.
Fixed a problem on RS-485 serial driver, which could cause
random errors on MODBUS RTU communication.
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Fixed an RTD reading error that affected a small group of
manufactured units
Changed the value of some resistors and capacitors for
standarization with other products (does not affects product’s
technical characteristics)
Change in manufacturing documentation to include additional
information for soldering the CPU crystal.
Changed to update status of digital input LEDs even with no
application loaded
Changed to blink 1x the DG LED when no application is loaded
Fixed company name on “Target Vendor” field on gateway scan
Removed log message generated when the system time is updated
by SNTP (to avoid log being flooded with this message)
Improved LED diagnostic indication
Included support for USB mass storage devices
Initial revision.

1.7.7.0

30/01/2019

1.7.7.0

05/12/2018

1.7.5.0
1.7.3.0
1.7.0.12

12/11/2018
26/10/2018
10/10/2018

Version

Date

1.12.5.3

15/12/2022

1.11.10.0

06/12/2022

1.11.10.0

04/07/2022

1.11.10.0

27/05/2022

1.11.10.0

04/03/2022

1.11.10.0

18/01/2022

1.11.2.0

27/10/2021

1.11.2.0

26/07/2021

2.2 BCS-XP315 – COMPACT PLC 16DI 16DO 5AI 2RTD – BJ
REV




BB








BA

AZ
AY
AX
AW
AV










AU



Description
Support for BCS Tools 3.40.
Fixed a problem where 3G/4G Modem could fail to reconnect after
a communication failure.
Increased the storage capability for the source code, stored now on
a 64MB space that is shared with application and Webvisu files. It
is necessary to reboot the controller without application to make
this new space available. The source code size verification
(warning message) was updated accordingly on BCS Tools 3.40.
Fixed possible issue where the Web Page turns unaccesible after
using it for a very long time.
Fixed the retain system to keep the values after a reboot caused by
an internal software error.
Fixed potential exception when an application is removed (reset
origin).
Included support for additional analog inputs using
LibIntegratedIoExt introduced on BCS Tools 3.40.
Minor hardware changes in order to improve the product.
Change of the product label, which now includes a QR Code with
the path to the Technical Documentation of the product on the
website. This change makes it unnecessary to follow the
Installation Guide with the product.
UKCA Certification marking included on product.
Improvement in the production process. Changed RTD settings in
product testing.
Minor hardware adjustments to support a new alternative part
number (due to the shortage of electronic components).
Minor hardware adjustments to support a new alternative part
number (due to the shortage of electronic components).
Changes in the source code shared with other products that doesn't
affect this product behavior.
Small changes in the produtct’s hardware to improve font startup
behavior, making startup faster.
New format of firmware update file. This update requires the
controller running on firmware version 1.9.29.0 or greater.
Added protection against CSRF (cross-site request forgery) for
management pages in web interface.
Included login mechanism for operation mode page in web
interface.
Included a new reset mechanism to solve connection failures of

Altus Sistemas de Automação S.A.

Page: 5

Revision History – Beijer Products


-





AT

AS







AR










AQ



AP
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Date(dd/mm/yyyy): 15/12/2022

USB modem.
Changed firmware update mechanism to include support for the
new file format that will be introduced on upcoming versions.
Included support for PROFINET Controller.
Included support to CAN J1939.
Included support for “number of connected clients” diagnostic in
status bar. To see this diagnostic, BCS-MT8500 version 3.31 or
greater is required.
Removed the hidden page “getlogs” from the system web page to
improve cyber security.
Change in the product hardware to support minimum operation
temperature of - 20ºC.
Included support for USB WiFi adapters.
Included suppport for additional USB modem devices: Huawei
E3276 and E8372.
Fixed a problem on the PTO fast output that could potentially turn
on the next normal digital output.
Fixed a problem that could lead to a negative offset on RTD
reading.
Fixed a problem where the digital input value was not updated on
the execution of external interrupt task.
Fixed a problem related to the system webpage cache. This
eliminates the need of clearing the cache on browser side, which
was previously required under some circumstances to show the
page correctly.
Updated the product label for compliance of the UL certification,
File Number E496087.
Included protectors for the product connectors.
Improved performance (CPU clock increased by 85% with
bootloader version 1.0.0.15 included on this version).
Included support to USB modem.
Included support to TLS v1.2 and client certificate in the Function
Block MQTT Client (the last one requires the BCS Tools 3.23 or
greater).
Improved immunity level of RTD inputs against external
electromagnetic interferences.
Fixed a problem that could cause corruption of operating system in
case of engergy interruption during a specific moment of power-up
process, leading the controller to a permanent inoperative state.
Fixed a problem on CANopen Remote I/O mode which could
eventually prevent the controller from starting up.
Improvements on CANopen Remote I/O mode.
Improvements on serial communication.
Included support for USB Serial RS-232 converter
Included support for the latest version of LibSQLClient library.
Included support for CANopen Manager (requires BCS Tools 3.19
or greater).
Included support for MQTT Client Function Block (requires BCS
Tools 3.19 or greater).
Fixed the diagnostic tDetailed.Serial.COM1.wRXPendingBytes
which stopped to work on previous version, affecting the Function
Block of Serial communication.
Fixed a situation that could cause a drift of RTC time higher than
the specified.
Included support for CAN termination configuration, introduced
on BCS Tools 3.19.
Included bootloader version 1.0.0.11, which increases the
immunity level against external electromagnetic interferences. The
bootloader is now included inside the firmware image file, and will
be updated automatically during the firmware update process
ONLY if the controller is running with version 1.7.49.0 or greater.

Altus Sistemas de Automação S.A.

1.9.29.0

26/07/2021

1.9.25.0

13/01/2021

1.9.17.0

28/12/2020

1.9.17.0

18/08/2020

1.9.9.0

29/05/2020

1.8.11.0

09/01/2020

1.8.5.0

11/12/2019

1.7.49.0

27/09/2019

Page: 6

Revision History – Beijer Products









AM
AL




AK




AJ











AI





AH




AG





AF
AE




Date(dd/mm/yyyy): 15/12/2022

If the firmware update process is performed on a controller with an
installed firmware lower than 1.7.49.0, it is required to perform the
update procedure AGAIN (i.e, twice, to the same version) to have
the bootloader updated.
Included support for Ethernet/IP Scanner.
Included support for I/O expansion through CANopen (CANopen
Slave mode).
Included support for 2400 and 4800 bits/s baudrates on the serial
communication.
Improvements on MODBUS RTU Slave timing, where sporadic
communication errors could occur on a RS-485 network composed
by several slaves.
Changed maximum source code size from 16MB to 26MB
(requires a reboot with no apllication to apply this increase; the
warning message updated on version 3.18 of BCS Tools).
Fixed EasyConnection behavior, where the application was not
being erased after applying the new IP adress, resulting on
returning to the IP address set by the application.
Improved mounting of USB mass storage devices, increasing the
compatiblity with certain models of flash drives.
Fixed maximum number of ARTI/OPC DA connections from 4 to
8.
Fixed generation of counter interrupt.
Replacement for the overlay flat cable connector part number and
change in the insertion procedure.
Included support for new homologated memories
Fixed external input I02, which stopped to work on previous
version.
Improvements on fast inputs and outputs.
Improvements on the USB mass storage mounting system.
Improved EMC immunity level
Included support for OPC UA protocol
Included support for MSSQL_Client Function Block for accessing
Microsoft databases.
Included a fixed DNS Server configuration (8.8.8.8 and 8.8.4.4)
Included support for Fast I/O (counters, external interrupts,
PTO/PWM outputs, ...)
Included support for FAT32 LBA filesystem, used on big capacity
USB mass storage devices
Fixed a problem on function GetTimeZone, which could cause an
exception leading the CPU to STOP.
Improvements on GetDateAndTime and GetDayOfWeek
functions, which could cause peak on execution time.
Fixed a problem on RS-485 serial driver, which could cause
random errors on MODBUS RTU communication
Fixed an RTD reading error that affected a small group of
manufactured units
Changed the value of some resistors and capacitors for
standarization with other products (does not affects product’s
technical characteristics)
Change in manufacturing documentation to include additional
information for soldering the CPU crystal.
Changed to update status of digital input LEDs even with no
application loaded
Changed to blink 1x the DG LED when no application is loaded
Fixed company name on “Target Vendor” field on gateway scan
Removed log message generated when the system time is updated
by SNTP (to avoid log being flooded with this message)
Improved LED diagnostic indication
Included support for USB mass storage devices
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1.7.40.0

07/09/2019

1.7.35.0

06/06/2019

1.7.35.0

21/05/2019

1.7.32.0

09/05/2019
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1.7.7.0
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1.7.5.0
1.7.3.0

12/11/2018
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Initial revision.

1.7.0.12

10/10/2018

Version

Date

1.12.5.3

15/12/2022

1.11.10.0

06/12/2022

1.11.10.0

04/07/2022

1.11.10.0

27/05/2022

1.11.10.0

04/03/2022

1.11.10.0

18/01/2022

1.11.2.0

27/10/2021

1.11.2.0

26/07/2021

1.9.29.0

26/07/2021

1.9.25.0

13/01/2021

1.9.17.0

28/12/2020

1.9.17.0

18/08/2020

1.9.17.0

18/08/2020

2.3 BCS-XP325 – COMPACT PLC 16DI 16DO 5AI 4AO 2RTD – BJ
REV




BF








BE

BD
BC
BB
BA
AZ










AY





-





AX

AW
AV
AU





Description
Support for BCS Tools 3.40.
Fixed a problem where 3G/4G Modem could fail to reconnect after
a communication failure.
Increased the storage capability for the source code, stored now on
a 64MB space that is shared with application and Webvisu files. It
is necessary to reboot the controller without application to make
this new space available. The source code size verification
(warning message) was updated accordingly on BCS Tools 3.40.
Fixed possible issue where the Web Page turns unaccesible after
using it for a very long time.
Fixed the retain system to keep the values after a reboot caused by
an internal software error.
Fixed potential exception when an application is removed (reset
origin).
Included support for additional analog inputs using
LibIntegratedIoExt introduced on BCS Tools 3.40.
Minor hardware changes in order to improve the product.
Change of the product label, which now includes a QR Code with
the path to the Technical Documentation of the product on the
website. This change makes it unnecessary to follow the
Installation Guide with the product.
UKCA Certification marking included on product.
Improvement in the production process. Changed RTD settings in
product testing.
Minor hardware adjustments to support a new alternative part
number (due to the shortage of electronic components).
Minor hardware adjustments to support a new alternative part
number (due to the shortage of electronic components).
Changes in the source code shared with other products that doesn't
affect this product behavior.
Small changes in the produtct’s hardware to improve font startup
behavior, making startup faster.
New format of firmware update file. This update requires the
controller running on firmware version 1.9.29.0 or greater.
Added protection against CSRF (cross-site request forgery) for
management pages in web interface.
Included login mechanism for operation mode page in web
interface.
Included a new reset mechanism to solve connection failures of
USB modem.
Changed firmware update mechanism to include support for the
new file format that will be introduced on upcoming versions.
Included support for PROFINET Controller.
Included support to CAN J1939.
Included support for “number of connected clients” diagnostic in
status bar. To see this diagnostic, BCS-MT8500 version 3.31 or
greater is required.
Removed the hidden page “getlogs” from the system web page to
improve cyber security.
Change in the product hardware to support minimum operation
temperature of - 20ºC.
Updated the product label for compliance of the UL certification,
File Number E496087.
Included support for USB WiFi adapters.
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Included suppport for additional USB modem devices: Huawei
E3276 and E8372.
Fixed a problem on the PTO fast output that could potentially turn
on the next normal digital output.
Fixed a problem that could lead to a negative offset on RTD
reading.
Fixed a problem where the digital input value was not updated on
the execution of external interrupt task.
Fixed a problem related to the system webpage cache. This
eliminates the need of clearing the cache on browser side, which
was previously required under some circumstances to show the
page correctly.
Included protectors for the product connectors.
Improved performance (CPU clock increased by 85% with
bootloader version 1.0.0.15 included on this version).
Included support to USB modem.
Included support to TLS v1.2 and client certificate in the Function
Block MQTT Client (the last one requires the BCS Tools 3.23 or
greater).
Improved immunity level of RTD inputs against external
electromagnetic interferences.
Fixed a problem that could cause corruption of operating system in
case of engergy interruption during a specific moment of power-up
process, leading the controller to a permanent inoperative state.
Fixed a problem on CANopen Remote I/O mode which could
eventually prevent the controller from starting up.
Improvements on CANopen Remote I/O mode.
Improvements on serial communication.
Included support for USB Serial RS-232 converter
Included support for the latest version of LibSQLClient library.
Included support for MQTT Client Function Block (requires BCS
Tools 3.19 or greater).
Fixed the diagnostic tDetailed.Serial.COM1.wRXPendingBytes
which stopped to work on previous version, affecting the Function
Block of Serial communication.
Fixed a situation that could cause a drift of RTC time higher than
the specified.
Included support for CAN termination configuration, introduced
on BCS Tools 3.19.
Included bootloader version 1.0.0.11, which increases the
immunity level against external electromagnetic interferences. The
bootloader is now included inside the firmware image file, and will
be updated automatically during the firmware update process
ONLY if the controller is running with version 1.7.49.0 or greater.
If the firmware update process is performed on a controller with an
installed firmware lower than 1.7.49.0, it is required to perform the
update procedure AGAIN (i.e, twice, to the same version) to have
the bootloader updated.
Included support for Ethernet/IP Scanner.
Included support for I/O expansion through CANopen (CANopen
Slave mode).
Included support for 2400 and 4800 bits/s baudrates on the serial
communication.
Improvements on MODBUS RTU Slave timing, where sporadic
communication errors could occur on a RS-485 network composed
by several slaves.
Changed maximum source code size from 16MB to 26MB
(requires a reboot with no apllication to apply this increase; the
warning message updated on version 3.18 of BCS Tools).
Fixed EasyConnection behavior, where the application was not
being erased after applying the new IP adress, resulting on
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Date(dd/mm/yyyy): 15/12/2022

returning to the IP address set by the application.
Improved mounting of USB mass storage devices, increasing the
compatiblity with certain models of flash drives.
Fixed maximum number of ARTI/OPC DA connections from 4 to
8.
Fixed generation of counter interrupt.
Replacement for the overlay flat cable connector part number and
change in the insertion procedure.
Included support for new homologated memories
Fixed external input I02, which stopped to work on previous
version.
Improvements on fast inputs and outputs.
Improvements on the USB mass storage mounting system.
Improvements in CANopen Manager performance.
Improved EMC immunity level
Included support for OPC UA protocol
Included support for MSSQL_Client Function Block for accessing
Microsoft databases.
Included a fixed DNS Server configuration (8.8.8.8 and 8.8.4.4)
Included support for Fast I/O (counters, external interrupts,
PTO/PWM outputs, ...)
Included support for CANopen Manager
Included support for FAT32 LBA filesystem, used on big capacity
USB mass storage devices
Fixed a problem on function GetTimeZone, which could cause an
exception leading the CPU to STOP.
Improvements on GetDateAndTime and GetDayOfWeek
functions, which could cause peak on execution time.
Fixed a problem on RS-485 serial driver, which could cause
random errors on MODBUS RTU communication
Fixed an RTD reading error that affected a small group of
manufactured units
Changed the value of some resistors and capacitors for
standarization with other products (does not affects product’s
technical characteristics)
Change in manufacturing documentation to include additional
information for soldering the CPU crystal.
Changed to update status of digital input LEDs even with no
application loaded
Changed to blink 1x the DG LED when no application is loaded
Fixed company name on “Target Vendor” field on gateway scan
Removed log message generated when the system time is updated
by SNTP (to avoid log being flooded with this message)
Improved LED diagnostic indication
Included support for USB mass storage devices
Initial revision.

1.7.40.0

07/09/2019

1.7.35.0

06/06/2019

1.7.35.0

21/05/2019

1.7.32.0

09/05/2019

1.7.17.0

15/03/2019

1.7.7.0

30/01/2019

1.7.7.0

05/12/2018

1.7.5.0
1.7.3.0
1.7.0.12

12/11/2018
26/10/2018
10/10/2018

2.4 BCS-XP340 – COMPACT PLC 16DI 16DO 5AI 4AO 2RTD WEB – BJ
REV



AN



Description
Version
Support for BCS Tools 3.40.
Fixed a problem where 3G/4G Modem could fail to reconnect after
a communication failure.
Increased the storage capability for the source code, stored now on
a 64MB space that is shared with application and Webvisu files. It 1.12.5.3
is necessary to reboot the controller without application to make
this new space available. The source code size verification
(warning message) was updated accordingly on BCS Tools 3.40.
Fixed possible issue where the Web Page turns unaccesible after
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Date(dd/mm/yyyy): 15/12/2022

using it for a very long time.
Fixed the retain system to keep the values after a reboot caused by
an internal software error.
Fixed potential exception when an application is removed (reset
origin).
Included support for additional analog inputs using
LibIntegratedIoExt introduced on BCS Tools 3.40.
Minor hardware changes in order to improve the product.
Change of the product label, which now includes a QR Code with
the path to the Technical Documentation of the product on the
website. This change makes it unnecessary to follow the
Installation Guide with the product.
UKCA Certification marking included on product.
Improvement in the production process. Changed RTD settings in
product testing.
Minor hardware adjustments to support a new alternative part
number (due to the shortage of electronic components).
Minor hardware adjustments to support a new alternative part
number (due to the shortage of electronic components).
Changes in the source code shared with other products that doesn't
affect this product behavior.
Small changes in the produtct’s hardware to improve font startup
behavior, making startup faster.
New format of firmware update file. This update requires the
controller running on firmware version 1.9.29.0 or greater.
Added protection against CSRF (cross-site request forgery) for
management pages in web interface.
Included login mechanism for operation mode page in web
interface.
Included a new reset mechanism to solve connection failures of
USB modem.
Fixed misaligned memory exception due to IEC104 server
mappings.
Changed firmware update mechanism to include support for the
new file format that will be introduced on upcoming versions.
Included support for PROFINET Controller.
Included support to CAN J1939.
Included support for “number of connected clients” diagnostic in
status bar. To see this diagnostic, BCS-MT8500 version 3.31 or
greater is required.
Removed the hidden page “getlogs” from the system web page to
improve cyber security.
Change in the product hardware to support minimum operation
temperature of - 20ºC.
Included support for USB WiFi adapters.
Included suppport for additional USB modem devices: Huawei
E3276 and E8372.
Fixed a problem on the PTO fast output that could potentially turn
on the next normal digital output.
Fixed a problem that could lead to a negative offset on RTD
reading.
Fixed a problem where the digital input value was not updated on
the execution of external interrupt task.
Fixed a problem related to the system webpage cache. This
eliminates the need of clearing the cache on browser side, which
was previously required under some circumstances to show the
page correctly.
Updated the product label for compliance of the UL certification,
File Number E496087.
Included protectors for the product connectors.
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1.11.10.0

06/12/2022

1.11.10.0

04/07/2022

1.11.10.0

27/05/2022

1.11.10.0

04/03/2022

1.11.10.0

18/01/2022

1.11.2.0

27/10/2021

1.11.2.0

26/07/2021

1.9.29.0

26/07/2021

1.9.25.0

13/01/2021

1.9.17.0

28/12/2020

1.9.17.0

18/08/2020
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Date(dd/mm/yyyy): 15/12/2022

Improved performance (CPU clock increased by 85% with
bootloader version 1.0.0.15 included on this version).
Included support for IEC 104 Server protocol (requires BCS Tools
3.23 or greater)
Included support to USB modem.
Included support to TLS v1.2 and client certificate in the Function
Block MQTT Client (the last one requires the BCS Tools 3.23 or
greater).
Improved immunity level of RTD inputs against external
electromagnetic interferences.
1.9.9.0
Fixed a problem that could eventually generate an error when
downloading an application with Webvisu.
Fixed a problem that could cause corruption of operating system in
case of engergy interruption during a specific moment of power-up
process, leading the controller to a permanent inoperative state.
Fixed a problem on CANopen Remote I/O mode which could
eventually prevent the controller from starting up.
Improvements on CANopen Remote I/O mode.
Improvements on serial communication.
Included support for USB Serial RS-232 converter
1.8.11.0
Included support for the latest version of LibSQLClient library.
1.8.5.0
Initial revision.

29/05/2020

09/01/2020
11/12/2019

2.5 BCS-XP350 – COMPACT PLC 16DI 16DO 5AI 2RTD MOTION – BJ
REV
AA

Description


Initial revision.

Version
1.12.5.3

Date
15/12/2022

2.6 BCS-NX3003 – CPU 1 ETH, 1 SERIAL, 14 DI, 10 DO AND PSU 10W – BJ
REV


AS




AR




AQ




-

AP







Descrição
Support for BCS Tools 3.40.
Fixed possible issue where the Web Page turns unaccesible after
using it for a very long time.
Fixed the retain system to keep the values after a reboot caused by
an internal software error.
Fixed potential exception when an application is removed (reset
origin).
In this revision there were only internal changes in the
documentation.
New format of firmware update file. This update requires the
controller running on firmware version 1.9.29.0 or greater.
Added protection against CSRF (cross-site request forgery) for
management pages in web interface.
Changed firmware update mechanism to include support for the
new file format that will be introduced on upcoming versions.
Improvements in “one touch diag” feature.
Included support for PROFINET Controller.
Included support for “number of connected clients” diagnostic in
status bar. To see this diagnostic, BCS-MT8500 version 3.31 or
greater is required.
Removed the hidden page “getlogs” from the system web page to
improve cyber security.
Fixed a problem related to the system webpage cache. This
eliminates the need of clearing the cache on browser side, which
was previously required under some circumstances to show the
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Date

1.12.5.3

15/12/2022

1.11.2.0

06/09/2022

1.11.2.0

26/07/2021

1.9.29.0

26/07/2021

1.9.25.0

13/01/2021

Page: 12

Revision History – Beijer Products




AO



AN





AM











AL



AK

Date(dd/mm/yyyy): 15/12/2022

page correctly.
Fixed a problem where the digital input value was not updated on
the execution of external interrupt task.
Fixed a problem of delay in PTO softstop command when using
LibMachineOEM.LABELING_MACHINE function block.
Included support to TLS v1.2 and client certificate in the Function
Block MQTT Client (the last one requires the BCS Tools 3.23 or
greater).
Included protectors for the product connectors.
Included support for MQTT Client Function Block (requires BCS
Tools 3.19 or greater).
Included support for the latest version of LibSQLClient library.
Included support for Ethernet/IP Adapter and Scanner.
Included support for visualization of the integrated I/O by LCD
(menu Hardware).
Included support for labeling function of the LibMachineOEM
library (PTO).
Improvements in the performance of integrated fast I/O.
Fixed EasyConnection behavior, where the application was not
being erased after applying the new IP adress, resulting on
returning to the IP address set by the application.
Fixed maximum number of ARTI/OPC DA connections from 4 to
8.
General fixes on User Rights Management, which was not working
properly on version 1.7.x.x.
Improvements in the performance of integrated fast I/O.
Improvements in the performance of serial communication.
Improvements in CPU diagnostic messages.
Included watchdog reset diagnostic on the CPU display.
Changed bootloader from version 1.0.0.13 to 1.0.0.14 to fix an
issue where the CPU could activate (drive) the RS-485 bus during
the power-up.
Initial revision.

1.9.8.0

09/11//2020

1.8.11.0

24/09/2020

1.8.11.0

27/01/2020

1.7.36.0

11/06/2019

1.7.20.0

01/04/2019

2.7 BCS-NX3004 – CPU 1 ETH, 1 SERIAL PORT – BJ
REV


AT





AS



AR


-




Description
Support for BCS Tools 3.40.
Fixed possible issue where the Web Page turns unaccesible after using it
for a very long time.
Fixed the retain system to keep the values after a reboot caused by an
internal software error.
Fixed potential exception when an application is removed (reset origin).
Change of the product label, which now includes a QR Code with the
path to the Technical Documentation of the product on the website. This
change makes it unnecessary to follow the Installation Guide with the
product.
UKCA Certification marking included on product.
New format of firmware update file. This update requires the controller
running on firmware version 1.9.29.0 or greater.
Added protection against CSRF (cross-site request forgery) for
management pages in web interface.
Updated UL Mark adding cUL (Canada). Due to the process of
introduction on production line, this update may be present in some
units before this revision.
Changed firmware update mechanism to include support for the new file
format that will be introduced on upcoming versions.
Improvements in “one touch diag” feature.
Included support for PROFINET Controller.
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1.12.5.3
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1.11.2.0

01/11/2022

1.11.2.0

26/07/2021

1.9.29.0

26/07/2021
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Date(dd/mm/yyyy): 15/12/2022

Included support for “number of connected clients” diagnostic in status
bar. To see this diagnostic, BCS-MT8500 version 3.31 or greater is
required.
Removed the hidden page “getlogs” from the system web page to
improve cyber security.
Fixed a problem related to the system webpage cache. This eliminates
the need of clearing the cache on browser side, which was previously
required under some circumstances to show the page correctly.
Included support to TLS v1.2 and client certificate in the Function
Block MQTT Client (the last one requires the BCS Tools 3.23 or
greater).
Included protectors for the product connectors.
Included support for MQTT Client Function Block (requires BCS Tools
3.19 or greater).
Included support for the latest version of LibSQLClient library.
Included support for Ethernet/IP Adapter and Scanner.
Fixed an error that could occur when performing a specific sequence of
modification of the size of Retain/Persistent %Q area.
Fixed EasyConnection behavior, where the application was not being
erased after applying the new IP adress, resulting on returning to the IP
address set by the application.
Fixed maximum number of ARTI/OPC DA connections from 4 to 8.
General fixes on User Rights Management, which was not working
properly on version 1.7.x.x.
Included support for OPC UA protocol
Included support for MSSQL_Client Function Block for accessing
Microsoft databases.
Included a fixed DNS Server configuration (8.8.8.8 and 8.8.4.4)
Fixed the position of F symbol (force) on LCD
Improvements on Easy Connection feature
Fixed a problem on function GetTimeZone, which could cause an
exception leading the CPU to STOP.
Improvements on GetDateAndTime and GetDayOfWeek functions,
which could cause peak on execution time.
Removed log message generated when the system time is updated by
SNTP (to avoid log being flooded with this message)
Improvements on factory test system
This revision was skipped due to integration of internal documentation
Included support for NX9020 rack.
Enhancements in SNMP protocol
Added new configuration options for MODBUS Symbolic mode
(Server and Slave);
Added return of Easy Execution command execution status;
Including support for new Nexto Jet solution modules;
Improved Ethernet IP protocol;
Improved support for NVLs.
Included support to clock settings.
Included support to easy connection.
Included support to dynamic IP.
Included support to mixed analog module NJ6005.
Homologation of alternative part numbers for components used on this
product.
Enhancements in performance of the modules hot-swap circuit.
New revision of the printed circuit board.
Changed the product label to comply with the new revision of CE
directive.
Homologation of alternative part numbers for components used on this
product.
Included the support for flexibility of retain/persistent memory areas.
Included the support for Nexto Jet solution.
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1.9.25.0

13/01/2021

1.9.8.0

09/11/2020

1.8.11.0

24/09/2020

1.8.11.0

27/01/2020

1.7.17.0

11/03/2019

1.6.2.0
-

30/11/2018
-

1.6.2.0

08/02/2018

1.6.1.0

02/10/2017

1.6.0.5

06/01/2017

1.5.1.2

09/11/2016

1.5.1.2

21/06/2016

1.5.1.2

25/05/2016

1.5.1.2

18/12/2015
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Improvements on the presentation of module Tag on diagnostic web
page.
Included the support for SNMP (agent) protocol supporting MIBII and
Private.
Improvements on the UCP power down process and on data retentivity.
Improvements on the handling of data retentivity.
Initial revision.


AC
AB
AA

Date(dd/mm/yyyy): 15/12/2022





1.5.0.21

01/09/2015

1.5.0.18
1.5.0.16

15/06/2015
06/0652015

2.8 BCS-NX3005 – CPU 1 ETH, 1 SERIAL PORT , WEB - BJ
REV


AP





AO


AN




-





AM


AL





AK
AJ






AI





AH




Description
Version
Support for BCS Tools 3.40.
Fixed possible issue where the Web Page turns unaccesible after using
it for a very long time.
Fixed the retain system to keep the values after a reboot caused by an
1.12.5.3
internal software error.
Fixed potential exception when an application is removed (reset
origin).
Change of the product label, which now includes a QR Code with the
path to the Technical Documentation of the product on the website.
This change makes it unnecessary to follow the Installation Guide
1.11.2.0
with the product.
UKCA Certification marking included on product.
New format of firmware update file. This update requires the
controller running on firmware version 1.9.29.0 or greater.
1.11.2.0
Added protection against CSRF (cross-site request forgery) for
management pages in web interface.
Changed firmware update mechanism to include support for the new
file format that will be introduced on upcoming versions.
1.9.29.0
Improvements in “one touch diag” feature.
Included support for PROFINET Controller.
Updated UL Mark adding cUL (Canada). Due to the process of
introduction on production line, this update may be present in some
1.9.25.0
units before this revision.
Included support for “number of connected clients” diagnostic in
status bar. To see this diagnostic, BCS-MT8500 version 3.31 or
greater is required.
Removed the hidden page “getlogs” from the system web page to
1.9.25.0
improve cyber security.
Fixed a problem related to the system webpage cache. This eliminates
the need of clearing the cache on browser side, which was previously
required under some circumstances to show the page correctly.
Included support to TLS v1.2 and client certificate in the Function
Block MQTT Client (the last one requires the BCS Tools 3.23 or 1.9.8.0
greater).
Included protectors for the product connectors.
1.8.11.0
Included support for MQTT Client Function Block (requires BCS
Tools 3.19 or greater).
Included support for the latest version of LibSQLClient library.
Fixed an error that could occur when performing a specific sequence
of modification of the size of Retain/Persistent %Q area.
Fixed EasyConnection behavior, where the application was not being 1.8.11.0
erased after applying the new IP adress, resulting on returning to the
IP address set by the application.
Fixed maximum number of ARTI/OPC DA connections from 4 to 8.
General fixes on User Rights Management, which was not working
properly on version 1.7.x.x.
Included support for OPC UA protocol
1.7.17.0
Included support for MSSQL_Client Function Block for accessing
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15/12/2022

03/11/2022

26/07/2021

26/07/2021

26/07/2021

13/01/2021

09/11/2020
24/09/2020

27/01/2020

11/03/2019
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Date(dd/mm/yyyy): 15/12/2022

Microsoft databases.
Included a fixed DNS Server configuration (8.8.8.8 and 8.8.4.4)
Fixed the position of F symbol (force) on LCD
Improvements on Easy Connection feature
Fixed a problem on function GetTimeZone, which could cause an
exception leading the CPU to STOP.
Improvements on GetDateAndTime and GetDayOfWeek functions,
which could cause peak on execution time.
Removed log message generated when the system time is updated by
SNTP (to avoid log being flooded with this message)
Improvements on SNMP protocol
Improvements on factory test system
Updated the product label for compliance of the UL certification, File
Number E496087.
Included the licence IEC-104 in the BOM of the product.
Included support for NX9020 rack.
Enhancements in SNMP protocol
Added new configuration options for MODBUS Symbolic mode
(Server and Slave);
Added return of Easy Execution command execution status;
Including support for new Nexto Jet solution modules;
Improved Ethernet IP protocol;
Improved support for NVLs.
Included support to IEC104 server.
Included support to mixed analog module NJ6005.
Homologation of alternative part numbers for components used on this
product.
Enhancements in performance of the modules hot-swap circuit.
Initial revision.

1.6.2.0

30/11/2018

1.6.2.0

03/09/2018

1.6.2.0

08/02/2018

1.6.1.0

02/10/2017

1.6.0.13

06/01/2017

1.6.0.9
1.6.0.9

09/11/2016
08/09/2016

Version

Date

1.10.51.0

01/12/2022

1.10.51.0

21/10/2022

Version

Date

1.10.8.0

15/12/2022

1.9.4.0

19/10/2022

1.9.1.0

26/07/2021

2.9 BCS-NX3008 – CPU 3 ETH, 1 USB, 1 SERIAL, 1 CAN, WEB - BJ
REV


AH

AA-AG 

Description
Minor hardware changes in order to improve the product.
Change of the product label, which now includes a QR Code with the
path to the Technical Documentation of the product on the website.
This change makes it unnecessary to follow the Installation Guide
with the product.
UKCA Certification marking included on product.
Initial revision.

2.10 BCS-NX3010 – CPU 1 ETH, 2 SERIAL – BJ
REV
BO

BN









BM



Description
Support for BCS Tools 3.40.
Fixed wrong “Factory Missing” log message
Fixed the retain system to keep the values after a reboot caused by an
internal software error.
Fixed potential exception when an application is removed (reset origin).
Change of the product label, which now includes a QR Code with the
path to the Technical Documentation of the product on the website. This
change makes it unnecessary to follow the Installation Guide with the
product.
UKCA Certification marking included on product.
New format of firmware update file. This update requires the controller
running on firmware version 1.8.13.0 or greater.
Added protection against CSRF (cross-site request forgery) for
management pages in web interface.
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BJ


BI





-




BH







BF-BG



BE








BD





BC
AS-BB






AR


Date(dd/mm/yyyy): 15/12/2022

Changed firmware update mechanism to include support for the new file
format that will be introduced on upcoming versions.
Included fixed DNS server settings (8.8.8.8 and 8.8.4.4).
Improved NIC Teaming performance.
Updated UL Mark adding cUL (Canada). Due to the process of
introduction on production line, this update may be present in some
units before this revision.
Included support for PROFINET Controller.
Included support for “number of connected clients” diagnostic in status
bar. To see this diagnostic, BCS-MT8500 version 3.31 or greater is
required.
Removed the hidden page “getlogs” from the system web page to
improve cyber security.
Fixed a problem that was not allowing the CPU to go to RUN when the
application name was different from the default “Application”.
Fixed a problem related to the system webpage cache. This eliminates
the need of clearing the cache on browser side, which was previously
required under some circumstances to show the page correctly.
Included protectors for the product connectors.
Included support to client certificate in the Function Block MQTT
Client (requires the BCS Tools 3.23 or greater).
Fixed a problem that was not allowing to perform a firmware update
when the CPU had an application loaded.
Included support for MQTT Client Function Block (requires BCS Tools
3.19 or greater).
Included support for the latest version of LibSQLClient library.
General fixes on User Rights Management, which was not working
properly on version 1.7.x.x.
Updated the RJ45 connector of the Ethernet interfaces.
Fixed the copy from memory card to CPU.
Fixed EasyConnection behavior, where the application was not being
erased after applying the new IP adress, resulting on returning to the IP
address set by the application.
Included support for EtherNet/IP Scanner and Adapter
Improvement on Ethernet interface to avoid uncontrolled retransmission
of ACK message on IP conflict scenarios, which could impact on CPU
execution cycle.
Fixed the LCD menu for copying application on Memory Card, which
was missing since version 1.6.0.11.
Fixed log message "Retain restore from file failed" that was incorrectly
generated on power on.
Included support for OPC UA protocol
Included a fixed DNS Server configuration (8.8.8.8 and 8.8.4.4)
Improvements on Easy Connection feature
Fixed a problem on function GetTimeZone, which could cause an
exception leading the CPU to STOP.
Improvements on GetDateAndTime and GetDayOfWeek functions,
which could cause peak on execution time.
Fixed treatment of I/O modules on breakpoint condition on projects
using machine profile.
Removed log message generated when the system time is updated by
SNTP (to avoid log being flooded with this message)
Small text correction on Installation Guide
Updated the product label for compliance of the UL certification, File
Number E496087.
These revisions were skipped due to integration of internal
documentation
Added new configuration options for MODBUS Symbolic mode
(Server and Slave);
Added return of Easy Execution command execution status;
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1.8.13.0

26/07/2021

1.8.10.0

26/07/2021

1.8.10.0

21/05/2021

1.8.9.0

13/01/2021

1.8.8.0

24/09/2020

1.8.6.0

05/06/2020

1.8.3.0

27/01/2020

1.7.0.14

03/10/2019

1.7.0.11

09/07/2019

1.7.0.8

11/03/2019

1.6.1.3

15/01/2019

-

-

1.6.1.3

02/10/2017
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AJ





AI





AH

AG







Date(dd/mm/yyyy): 15/12/2022

Including support for new Nexto Jet solution modules;
Improved Ethernet IP protocol;
Included support to IEC104 server.
Included support to clock settings.
Included support to easy connection.
Included support to dynamic IP.
Included support to mixed analog module NJ6005.
Included support for MSSQL_Client Function Block for accessing
Microsoft databases.
Homologation of alternative part numbers for components used on this
product.
Enhancement of factory test software.
Components that belonged to a non-used circuit were removed to reduce
the product’s structure.
Changed the product label to comply with the new revision of CE
directive.
Homologation of alternative part numbers for components used on this
product.
Included SNTP diagnostics in MIB Private.
Fixed possible exception when using projects with Basic profile.
Included support for the additional option introduced on BCS Tools
2.05 that allows using Retain and Persistent variables on Function
Blocks.
Enhancements on EtherCAT protocol when used on situations with
heavy traffic on other Ethernet ports.
Included support for I/O modules of the Nexto Jet solution.
Included support for size flexibility of Retentive and Persistent memory
areas.
Fixed possible loss of system logs after a power failure.
Changed web message in case firmware update failure when there are
too many applications running.
Fixed a possible exception after performing hot-swap of modules on the
local bus.
Fixed a problem which causes exception after na online change in
Symbol Configuration.
Fixed a problem where the Retain and Persistent are intialized after an
exception.
Included the vital failure feature for NETs on projects with half-cluster
redundancy.
Included the support for new 8-position rack NX9000 on diagnostics of
web page.
Included the support for SNTP.
Changed the maximum number of communication channels
simultaneouly connected to CPU from 4 to 8.
Included the support for OPC protocol.
Included the support for Application CRC feature.
Included two new hot swap modes: Hot Swap Disabled and Hot Swap
Enabled with startup consistency.
Included the support for SNMP (agent) protocol supporting MIBII and
Private.
Included new system logs with userful information to help diagnosis
and troubleshooting.
System log is now retain (i.e, the log remains on memory even after
restarting the CPU).
Fixed the synchronism of forced BIT variables on redundant systems.
Included the support for NX6020 module.
Included the support for MODBUS Symbol drivers (Client/Server and
Master/Slave RTU).
Included the support for the library that provides User Log on Memory
Card.
Fixed the diagnostic indication in case of failure of the OTD key.

Altus Sistemas de Automação S.A.

1.6.0.11

06/01/2017

1.5.1.7

10/10/2016

1.5.1.7

08/06/2016

1.5.1.7

01/06/2016

1.5.1.7

26/02/2016

1.5.1.3

11/11/2015

1.5.0.15

04/08/2015

1.5.0.10

25/05/2015

1.4.0.33

24/09/2014

1.3.0.31

30/07/2014

1.3.0.22

09/01/2014
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Date(dd/mm/yyyy): 15/12/2022

Improvements on the Memory Card access.
Improvement of CPU boot time.
Included the support for NX6010 module.
Fixed diagnostic with quantities of system restart.
Improvement of initialization time.
Modified task priorities after RTS reset to keep the same behavior.
Improvement in bus scan time.
Improvemente and fixes in memory alocation.
Fixed the treatment of tasks that access the I/O simultaneously.
Enhancement and fix in bus interruption treatment.
Enhancement in the communication bus.
Changed the bill of materials to add the earthing spring holder.
RoHS compliant revision.
Enhancement in bus interruption treatment.
Modified internal identification code in the firmware.
Inclusion of module firmware version on web pages
Increased compatibility with some memory card models.
Fix in web presentation of architecture when used rack expansion.
Initial revision.

1.2.4.0

30/09/2013

1.2.2.3

28/06/2013

1.2.1.0

12/04/2013

1.2.1.0

22/01/2013

1.2.0.9

30/10/2012

1.2.0.7

23/08/2012

Version

Date

1.10.8.0

15/12/2022

1.9.4.0

01/11/2022

1.9.1.0

05/04/2022

1.9.1.0

26/07/2021

1.8.13.0

26/07/2021

1.8.10.0

21/05/2021

1.8.9.0

13/01/2021

1.8.8.0

24/09/2020

2.11 BCS-NX3020 – CPU 2 ETH, 2 SERIAL, RACK EXP. – BJ
REV
BL







BK



BJ






BI


BH






BG


BF




Description
Support for BCS Tools 3.40.
Fixed wrong “Factory Missing” log message
Fixed the retain system to keep the values after a reboot caused by an
internal software error.
Fixed potential exception when an application is removed (reset origin).
Fixed an exception that occurs when using DBP with its individual
elements ON/OFF mapped to MODBUS.
Change of the product label, which now includes a QR Code with the
path to the Technical Documentation of the product on the website. This
change makes it unnecessary to follow the Installation Guide with the
product.
UKCA Certification marking included on product.
In this revision there were only internal changes in the documentation.
New format of firmware update file. This update requires the controller
running on firmware version 1.8.13.0 or greater.
Added protection against CSRF (cross-site request forgery) for
management pages in web interface.
Updated UL Mark adding cUL (Canada). Due to the process of
introduction on production line, this update may be present in some
units before this revision.
Changed firmware update mechanism to include support for the new file
format that will be introduced on upcoming versions.
Included fixed DNS server settings (8.8.8.8 and 8.8.4.4).
Improved NIC Teaming performance.
Included support for PROFINET Controller.
Included support for “number of connected clients” diagnostic in status
bar. To see this diagnostic, BCS-MT8500 version 3.31 or greater is
required.
Removed the hidden page “getlogs” from the system web page to
improve cyber security.
Fixed a problem that was not allowing the CPU to go to RUN when the
application name was different from the default “Application”.
Fixed a problem related to the system webpage cache. This eliminates
the need of clearing the cache on browser side, which was previously
required under some circumstances to show the page correctly.
Included protectors for the product connectors.
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BD

BB-BC







BA








AZ





AY
AS-AX





AR




AQ











AP



AO
AN
AM
AL







Date(dd/mm/yyyy): 15/12/2022

Updated the RJ45 connector of the Ethernet interfaces.
Included support to client certificate in the Function Block MQTT
Client (requires the BCS Tools 3.23 or greater).
Fixed a problem that was not allowing to perform a firmware update
when the CPU had an application loaded.
Included support for MQTT Client Function Block (requires BCS Tools
3.19 or greater).
Included support for the latest version of LibSQLClient library.
General fixes on User Rights Management, which was not working
properly on version 1.7.x.x.
Fixed the copy from memory card to CPU.
Fixed EasyConnection behavior, where the application was not being
erased after applying the new IP adress, resulting on returning to the IP
address set by the application.
Improvement on Ethernet interface to avoid uncontrolled retransmission
of ACK message on IP conflict scenarios, which could impact on CPU
execution cycle.
Fixed the LCD menu for copying application on Memory Card, which
was missing since version 1.6.0.11.
Fixed log message "Retain restore from file failed" that was incorrectly
generated on power on.
Included support for OPC UA protocol
Included a fixed DNS Server configuration (8.8.8.8 and 8.8.4.4)
Improvements on Easy Connection feature
Fixed a problem on function GetTimeZone, which could cause an
exception leading the CPU to STOP.
Improvements on GetDateAndTime and GetDayOfWeek functions,
which could cause peak on execution time.
Fixed treatment of I/O modules on breakpoint condition on projects
using machine profile.
Removed log message generated when the system time is updated by
SNTP (to avoid log being flooded with this message)
Small text correction on Installation Guide
Updated the product label for compliance of the UL certification, File
Number E496087.
These revisions were skipped due to integration of internal
documentation
Included the licence IEC-104 in the BOM of the product.
Added new configuration options for MODBUS Symbolic mode
(Server and Slave);
Added return of Easy Execution command execution status;
Including support for new Nexto Jet solution modules;
Improved Ethernet IP protocol;
Included support to IEC104 server.
Included support to clock settings.
Included support to easy connection.
Included support to dynamic IP.
Included support to mixed analog module NJ6005.
Included support for MSSQL_Client Function Block for accessing
Microsoft databases.
Homologation of alternative part numbers for components used on this
product.
Enhancement of factory test software.
Components that belonged to a non-used circuit were removed to reduce
the product’s structure.
Changed the product label to comply with the new revision of CE
directive.
Homologation of alternative part numbers for components used on this
product.
Included SNTP diagnostics in MIB Private.
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1.8.6.0

29/04/2020

1.8.6.0

05/06/2020

1.8.3.0

27/01/2020

1.7.0.14

03/10/2019

1.7.0.11

09/07/2019

1.7.0.8

11/03/2019

1.6.1.3

15/01/2019

-

-

1.6.1.3

03/09/2018

1.6.1.3

02/10/2017

1.6.0.11

06/01/2017

1.5.1.7

10/10/2016

1.5.1.7

08/06/2016

1.5.1.7

01/06/2016

1.5.1.7

26/02/2016
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AI








AH





AG






AF

AE

AD
AC
AB
AA



















Date(dd/mm/yyyy): 15/12/2022

Fixed possible exception when using projects with Basic profile.
Included support for the additional option introduced on BCS Tools
2.05 that allows using Retain and Persistent variables on Function
Blocks.
Enhancements on EtherCAT protocol when used on situations with
heavy traffic on other Ethernet ports.
Included support for I/O modules of the Nexto Jet solution.
Included support for size flexibility of Retentive and Persistent memory
areas.
Fixed possible loss of system logs after a power failure.
Changed web message in case firmware update failure when there are
too many applications running.
Fixed a possible exception after performing hot-swap of modules on the
local bus.
Fixed a problem which causes exception after na online change in
Symbol Configuration.
Fixed a problem where the Retain and Persistent are intialized after an
exception.
Included the vital failure feature for NETs on projects with half-cluster
redundancy.
Included the support for EtherCAT Master.
Included the support for new 8-position rack NX9000 on diagnostics of
web page.
Changed the maximum number of communication channels
simultaneouly connected to CPU from 4 to 8.
Included the support for OPC protocol.
Included the support for Application CRC feature.
Included two new hot swap modes: Hot Swap Disabled and Hot Swap
Enabled with startup consistency.
Included the support for SNMP (agent) protocol supporting MIBII and
Private.
Included new system logs with userful information to help diagnosis
and troubleshooting.
System log is now retain (i.e, the log remains on memory even after
restarting the CPU).
Fixed the synchronism of forced BIT variables on redundant systems.
Included the support for NX6020 module.
Included the support for MODBUS Symbol drivers (Client/Server and
Master/Slave RTU).
Included the support for the library that provides User Log on Memory
Card.
Fixed the diagnostic indication in case of failure of the OTD key.
Improvements on the Memory Card access.
Improvement of CPU boot time.
Included the support for NX6010 module.
Fixed diagnostic with quantities of system restart.
Improvement of initialization time.
Modified task priorities after RTS reset to keep the same behavior.
Improvement in bus scan time.
Improvemente and fixes in memory alocation.
Fixed the treatment of tasks that access the I/O simultaneously.
Enhancement and fix in bus interruption treatment.
Enhancement in the communication bus.
Changed the bill of materials to add the earthing spring holder.
RoHS compliant revision.
Enhancement in bus interruption treatment.
Modified internal identification code in the firmware.
Initial revision.
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1.5.1.3

11/11/2015

1.5.0.15

04/08/2015

1.5.0.10

25/05/2015

1.4.0.33

24/09/2014

1.3.0.31

30/07/2014

1.3.0.22

09/01/2014

1.2.4.0

30/09/2013

1.2.2.3

28/06/2013

1.2.1.0

12/04/2013

1.2.1.0

22/01/2013

1.2.0.9

23/08/2012
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Date(dd/mm/yyyy): 15/12/2022

2.12 BCS-NX3030 - CPU 2 ETH, 2 SERIAL,RACK EXP,RED-BJ
REV
BN






BM








BL


-





BK


BJ



BI



BH








BG





BE-BF 

Description
Version
Support for BCS Tools 3.40.
1.10.8.0
Fixed wrong “Factory Missing” log message
Fixed the redundancy project synchronization system when
downloading an application in a Stand-By CPU with the other still in
Active (an invalid operation).
Fixed the retain system to keep the values after a reboot caused by an
internal software error.
Fixed potential exception when an application is removed (reset origin).
Fixed an exception that occurs when using DBP with its individual
1.9.4.0
elements ON/OFF mapped to MODBUS.
Change of the product label, which now includes a QR Code with the
path to the Technical Documentation of the product on the website. This
change makes it unnecessary to follow the Installation Guide with the
product.
UKCA Certification marking included on product.
New format of firmware update file. This update requires the controller
running on firmware version 1.8.13.0 or greater.
Added protection against CSRF (cross-site request forgery) for
management pages in web interface.
1.9.1.0
Updated UL Mark adding cUL (Canada). Due to the process of
introduction on production line, this update may be present in some
units before this revision.
Changed firmware update mechanism to include support for the new file
format that will be introduced on upcoming versions.
1.8.13.0
Included fixed DNS server settings (8.8.8.8 and 8.8.4.4).
Improved NIC Teaming performance.
Fixed the NX4010 redundancy diagnostics presentation on the Web
interface.
1.8.10.0
Included support for PROFINET Controller.
Included support for “number of connected clients” diagnostic in status
bar. To see this diagnostic, BCS-MT8500 version 3.31 or greater is
required.
1.8.9.0
Removed the hidden page “getlogs” from the system web page to
improve cyber security.
Fixed the force diagnostic bForcedIOs, which was not being informed
correectly on the stand-by PLC.
Fixed a problem that was not allowing the CPU to go to RUN when the
application name was different from the default “Application”.
1.8.8.0
Fixed a problem related to the system webpage cache. This eliminates
the need of clearing the cache on browser side, which was previously
required under some circumstances to show the page correctly.
Included protectors for the product connectors.
Updated the RJ45 connector of the Ethernet interfaces.
1.8.6.0
Included support to client certificate in the Function Block MQTT
Client (requires the BCS Tools 3.23 or greater).
Fixed a problem that was not allowing to perform a firmware update
when the CPU had an application loaded.
1.8.6.0
Fixed a problem introduced on the previous version which reduced the
capability of the redundant system on tolerating an internal software
failure in one of the CPUs.
Included support for MQTT Client Function Block (requires BCS Tools
3.19 or greater).
Included support for the latest version of LibSQLClient library.
1.8.3.0
General fixes on User Rights Management, which was not working
properly on version 1.7.x.x.
Fixed the copy from memory card to CPU.
Fixed EasyConnection behavior, where the application was not being
1.7.0.14
erased after applying the new IP adress, resulting on returning to the IP
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Date
15/12/2022

01/11/2022

26/07/2021

26/07/2021

21/05/2021

13/01/2021

24/09/2020

29/04/2020

05/06/2020

27/01/2020

03/10/2019
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Date(dd/mm/yyyy): 15/12/2022

address set by the application.
Improvement on Ethernet interface to avoid uncontrolled retransmission
of ACK message on IP conflict scenarios, which could impact on CPU
execution cycle.
Fixed the LCD menu for copying application on Memory Card, which
was missing since version 1.6.0.11.
Fixed log message "Retain restore from file failed" that was incorrectly
generated on power on.
Included support to the fix introduced on BCS Tools v3.14 for the error
which could cause exception after a switchover of redundant PLC.
Included support for OPC UA protocol
Included a fixed DNS Server configuration (8.8.8.8 and 8.8.4.4)
Improvements on Easy Connection feature
Fixed a problem on function GetTimeZone, which could cause an
exception leading the CPU to STOP.
Improvements on GetDateAndTime and GetDayOfWeek functions,
which could cause peak on execution time.
Improvements on project synchonization between redundant PLCs
Fixed treatment of I/O modules on breakpoint condition on projects
using machine profile.
Removed log message generated when the system time is updated by
SNTP (to avoid log being flooded with this message)
Small text correction on Installation Guide
Updated the product label for compliance of the UL certification, File
Number E496087.
These revisions were skipped due to integration of internal
documentation
Included the licence IEC-104 in the BOM of the product.
Added new configuration options for MODBUS Symbolic mode
(Server and Slave);
Added return of Easy Execution command execution status;
Including support for new Nexto Jet solution modules;
Improved Ethernet IP protocol;
Improved synchronization of redundant projects;
Included support to IEC104 server.
Included support to clock settings.
Included support to easy connection.
Included support to dynamic IP.
Included support to mixed analog module NJ6005.
Included support for MSSQL_Client Function Block for accessing
Microsoft databases.
Homologation of alternative part numbers for components used on this
product.
Enhancement of factory test software.
Components that belonged to a non-used circuit were removed to reduce
the product’s structure.
Changed the product label to comply with the new revision of CE
directive.
Homologation of alternative part numbers for components used on this
product.
Included SNTP diagnostics in MIB Private.
Fixed possible exception when using projects with Basic profile.
Included support for the additional option introduced on BCS Tools
2.05 that allows using Retain and Persistent variables on Function
Blocks.
Enhancements on EtherCAT protocol when used on situations with
heavy traffic on other Ethernet ports.
Enhancements on handling of redundant variables forcing.
Included support for I/O modules of the Nexto Jet solution.
Included support for size flexibility of Retentive and Persistent memory
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1.7.0.11

09/07/2019

1.7.0.8

11/03/2019

1.6.1.3

15/01/2019

-

-

1.6.1.3

03/09/2018

1.6.1.3

02/10/2017

1.6.0.11

06/01/2017

1.5.1.7

10/10/2016

1.5.1.7

08/06/2016

1.5.1.7

01/06/2016

1.5.1.7

26/02/2016

1.5.1.3

11/11/2015
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Date(dd/mm/yyyy): 15/12/2022

areas.
Fixed possible loss of system logs after a power failure.
Changed web message in case firmware update failure when there are
too many applications running.
Incremented the maximum number of redundant areas from 100 to
1024.
Fixed a possible exception after performing hot-swap of modules on the
local bus.
Fixed forcing of variables on redundant system.
Fixed a problem which causes exception after na online change in
Symbol Configuration.
Fixed a problem where the Retain and Persistent are intialized after an
exception.
Included the vital failure feature for NETs on projects with half-cluster
redundancy.
Included the support for EtherCAT.
Included the support for new 8-position rack NX9000 on diagnostics of
web page.
Included the support for.
Changed the maximum number of communication channels
simultaneouly connected to CPU from 4 to 8.
Included the support for OPC protocol.
Included the support for Application CRC feature.
Included two new hot swap modes: Hot Swap Disabled and Hot Swap
Enabled with startup consistency.
Included the support for SNMP (agent) protocol supporting MIBII and
Private.
Included new system logs with userful information to help diagnosis
and troubleshooting.
System log is now retain (i.e, the log remains on memory even after
restarting the CPU).
Fixed the synchronism of forced BIT variables on redundant systems.
Included the support for NX6020 module.
Included the support for MODBUS Symbol drivers (Client/Server and
Master/Slave RTU).
Included the support for the library that provides User Log on Memory
Card.
Fixed the diagnostic indication in case of failure of the OTD key.
Improvements on the Memory Card access.
Improvement of CPU boot time.
Included the support for NX6010 module.
Fixed diagnostic with quantities of system restart.
Improvement of initialization time.
Modified task priorities after RTS reset to keep the same behavior.
Improvement in bus scan time.
Improvemente and fixes in memory alocation.
Fixed the treatment of tasks that access the I/O simultaneously.
Fixed project synchronization after a restart of standby PLC.
Fixed the timout to synchronize the project.
Enhancement and fix in bus interruption treatment.
Enhancement in the communication bus.
Fix in the redundant project synchronism.
Changed the bill of materials to add the earthing spring holder.
Initial revision.

1.5.0.15

04/08/2015

1.5.0.10

25/05/2015

1.4.0.33

29/09/2014

1.3.0.31

30/07/2014

1.3.0.22

09/01/2014

1.2.4.0

30/09/2013

1.2.2.3

28/06/2013

1.2.1.0
1.2.1.0

12/04/2013
22/01/2013

Version
NA

Date
01/12/2022

2.13 BCS-NX8000 - 30W 24VDC PSU - BJ
REV Description
AQ  Minor hardware changes in order to improve the product.
Altus Sistemas de Automação S.A.
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Date(dd/mm/yyyy): 15/12/2022

Change of the product label, which now includes a QR Code with the
path to the Technical Documentation of the product on the website. This
change makes it unnecessary to follow the Installation Guide with the
product.
UKCA Certification marking included on product.
Updated UL Mark adding cUL (Canada). Due to the process of
introduction on production line, this update may be present in some
units before this revision.
Updated the product label for compliance of the UL certification, File
Number E496087.
These revisions were skipped due to integration of internal
documentation
This new product revision is related to the change in the overlay
material.
Homologation of alternative part numbers for components used on this
product.
Changed the product label to comply with the new revision of CE
directive.
Enhancement on test system for test of NX3004.
Enhancement on test system to improve detection of module
interference on WSDE line (rack number).
Changed the maintenance procedure.
Changed the bill of materials to add the earthing sping holder.
RoHS compliant revision.
Label printed using a new printer.
Initial revision.

NA

26/07/2021

NA

04/06/2020

-

-

NA

12/09/2018

NA

19/12/2016

NA

22/09/2016

NA

30/12/2015

NA

17/06/2014

NA
NA
NA
NA
NA

20/05/2014
12/04/2013
22/01/2013
30/10/2012
31/08/2012

Version

Date

1.2.0.7

22/03/2022

1.2.0.7

26/07/2021

1.2.0.7

24/06/2020

1.2.0.7

15/08/2017

1.2.0.4

31/08/2016

1.2.0.4

14/06/2016

1.2.0.4

28/10/2015

1.2.0.4

12/06/2014

1.1.0.3
1.1.0.1
1.1.0.1
1.0.0.0

15/08/2013
12/04/2013
09/02/2013
24/10/2012

Version
1.2.0.20

Date
22/03/2022

2.14 BCS-NX1005 - 24 VDC 8 DOT/8 DI MIXED MODULE - BJ
REV Description
 Minor improvement in the external mechanics of the product, without
AL
significant impact.

Updated UL Mark adding cUL (Canada). Due to the process of
AK
introduction on production line, this update may be present in some
units before this revision.

Updated the product label for compliance of the UL certification, File
AJ
Number E496087.

Changes in the source code shared with other products that doesn’t
AI
affect the behaviour of this product.
 Enhancement in factory process.
AH  Changed the product label to comply with the new revision of CE
directive.
 Homologation of alternative part numbers for components used on this
AG
product.
AF  Impovements in the Factory Test system.
 Approval on EtherCAT Conformance Test.
AE
 Included the support for operation with Xtorm Series.
AD  Fixed the use of External Event on operating modes 2,3 and 4.
AC  Changed the bill of materials to add the earthing spring holder.
AB  RoHS compliant revision.
AA  Initial revision.
2.15 BCS-NX1001 - 24 VDC 16 DI MODULE – BJ
REV Description
AN  Minor improvement in the external mechanics of the product, without
Altus Sistemas de Automação S.A.
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Date(dd/mm/yyyy): 15/12/2022

significant impact.
Updated UL Mark adding cUL (Canada). Due to the process of
introduction on production line, this update may be present in some
units before this revision.
Updated the product label for compliance of the UL certification, File
Number E496087.
Changes in the test system for including new product.
Changes the time of Burn In.
Enhancements for reducing the threshold voltage of internal voltage
regulator.
Enhancement in factory process.
Changed the product label to comply with the new revision of CE
directive.
Homologation of alternative part numbers for components used on this
product.
Improve the performance of the input update time.
Fixed the support of filters for the inputs of Group 1.
Approval on EtherCAT Conformance Test.
Included the support for operation with Xtorm Series.
Fixed the use of External Event on operating modes 2,3 and 4.
Changed the bill of materials to added the the earthing sping holder.
RoHS compliant revision.
Changed the PCI – revision B.
Initial revision.

1.2.0.20

26/07/2021

1.2.0.20

24/06/2020

1.2.0.20

15/08/2017

1.2.0.20

01/02/2017

1.2.0.20

31/08/2016

1.2.0.20

14/06/2016

1.2.0.20

28/10/2015

1.2.0.3

13/06/2014

1.1.0.2
1.1.0.1
1.1.0.1
1.0.0.9
1.0.0.0

15/08/2013
12/04/2013
14/02/2013
30/10/2012
21/08/2012

2.16 BCS-NX6000 - 8 AI VOLTAGE/CURRENT MODULE - BJ
REV Description
Version
 Change of the product label, which now includes a QR Code with the
path to the Technical Documentation of the product on the website. This
BB
change makes it unnecessary to follow the Installation Guide with the 1.4.0.0
product.
 UKCA Certification marking included on product.
 Minor improvement in the external mechanics of the product, without
BA
1.4.0.0
significant impact.
 Updated UL Mark adding cUL (Canada). Due to the process of
AZ
introduction on production line, this update may be present in some
1.4.0.0
units before this revision.
 Included support for the new option “Disabled” for the parameter “Open
AY
1.4.0.0
Loop Value”.
 This new product revision is related to test system modifications for
AX
1.3.0.7
including other module in test system.
 These revisions were skipped due to integration of internal
AR-AW
documentation
 This new product revision is related to the change in the product overlay
AQ
1.3.0.7
to fix the opening of the display window.
 Enhancements of diagnostics detection of analog inputs.
AP
1.3.0.7
 Enhancements in detection of loss of bus master.
 This new product revision is related to test system modifications for
AO
1.3.0.3
including other module in test system.
AN  Enhancements on immunity against electromagnetic interference.
1.3.0.3
 Changed the product label to comply with the new revision of CE
AM
1.3.01
directive.
AL  Enhancement in factory process.
1.3.0.1
 Homologation of alternative part numbers for components used on this
AK
1.3.0.1
product.
AJ  Enhancements on the protection circuit of analog inputs.
1.3.0.1
AI  Enhancements on the calibration process of the module (performed
1.3.0.1
Altus Sistemas de Automação S.A.

Date

02/12/2022

22/03/2022
26/07/2021
03/09/2019
05/12/2018
24/04/2018
15/02/2018
15/09/2017
10/08/2016
08/06/2016
13/05/2016
11/05/2016
16/11/2015
03/11/2015
Page: 26

Revision History – Beijer Products

AH
AG
AF
AE
AD
AC
AB
AA















Date(dd/mm/yyyy): 15/12/2022

during factory test).
Addition of a new scale +-5Vdc.
Enhancements on the configuration process of the module.
Enhancements on the calibration process of the analog channels
(performed during factory test).
Approval on EtherCAT Conformance Test.
Included the support for operation with Xtorm Series.
Enhancements in the assembly instructions.
Enhancements in the Factory Test procedure.
Changed the bill of materials.
Changes the software version to improve the behavior of hot swap,
callibration process and reset operations.
Changed the bill of materials to add earthing sping holder.
RoHS compliant revision.
Changed the EtherCAT vendor ID.
Initial revision.

1.2.0.6

03/12/14

1.2.0.4

05/06/14

1.0.1.8
1.0.1.8

28/05/14
14/03/14

1.0.1.8

12/07/2013

1.0.1.2

26/04/2013

1.0.1.2

21/02/2013

1.0.0.14

24/10/2012

Version
1.0.0.16

Date
10/05/2022

1.0.0.14

22/03/2022

1.0.0.14

29/07/2021

-

-

1.0.0.14

17/04/2018

1.0.0.13

15/09/2017

1.0.0.11

10/08/2016

1.0.0.9

08/07/2016

1.0.0.6

13/05/2016

1.0.0.6

11/05/2016

1.0.0.6

03/11/2015

1.0.0.5

03/12/2014

1.0.0.4

12/06/2014

2.17 BCS-NX6010 - 8 AI THERMOCOUPLE MODULE - BJ
REV Description
AO 
Enhancements on immunity against electromagnetic interference.
 Minor improvement in the external mechanics of the product, without
AN
significant impact.

Updated UL Mark adding cUL (Canada). Due to the process of
AM
introduction on production line, this update may be present in some
units before this revision.

These revisions were skipped due to integration of internal
AJ-AL
documentation
AI 
Changes in the scope of the source to add the BCS NJ6011 module
 Enhancements on the calibration process of the module (performed
AH
during factory test).
 Additional enhancements on immunity against electromagnetic
AG
interference.
 Enhancements on immunity against electromagnetic interference.
AF  Changed the product label to comply with the new revision of CE
directive.
AE  Enhancement in factory process.
 Homologation of alternative part numbers for components used on this
AD
product.
 Enchancements on the calibration process of the module (performed
AC
during factory test).
 Approval on EtherCAT Conformance Test.
 Enhancement on the module’s calibration procedure during production
AB
process.
AA  Initial revision.

2.18 BCS-NX6020 - 8 AI RTD MODULE - BJ
REV Description
Version
 Minor improvement in the external mechanics of the product, without
AN
1.1.0.8
significant impact.
 Updated UL Mark adding cUL (Canada). Due to the process of
AM
introduction on production line, this update may be present in some 1.1.0.8
units before this revision.
 Support for the new hardware revision which introduces additional
AL
1.1.0.8
improvements to immunity against electromagnetic interferences.
Altus Sistemas de Automação S.A.

Date
22/03/2022
29/07/2021
29/09/2020
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Updated the product label for compliance of the UL certification, File
Number E496087
This revision was skipped due to integration of internal documentation
This new product revision is related to the change in the product overlay
to fix the opening of the display window.
This new product revision is related to modifications for including other
module in test system.
This new product revision refers to the new revision of the front label of
the product, in which the indication of A next to the identification
(BCS-NX6020 A) has been added so that it conforms to the standard of
the Nexto Series. In addition, the Burn In time was changed.
Improved immunity against electromagnetic interferences.
Changed the product label to comply with the new revision of CE
directive.
Homologation of alternative part numbers for components used on this
product.
Addition of a new scale of 10kΩ.
Fixed the display treatment for unsigned modules.
Fixed the OTD button test on factory test mode.
Enhancement on the module’s reconfiguration after communication
loss.
Initial revision.

1.1.0.3

24/06/2020

-

-

1.1.0.3

24/04/2018

1.1.0.3

15/09/2017

1.1.0.3

08/05/2017

1.1.0.3

13/01/2017

1.1.0.1

20/05/2016

1.1.0.1

18/05/2016

1.1.0.1

03/11/2015

1.0.0.3

15/05/2014

1.0.0.0

21/02/2014

2.19 BCS-NX2001 - 24 VDC 16 DO TRANSISTOR MODULE - BJ
REV Description
Version
Date
 Minor improvement in the external mechanics of the product, without
AM
1.2.0.8
16/12/2021
significant impact.
 Updated UL Mark adding cUL (Canada). Due to the process of
AL
introduction on production line, this update may be present in some 1.2.0.8
26/07/2021
units before this revision.
 Updated the product label for compliance of the UL certification, File
AK
1.2.0.8
24/06/2020
Number E496087.
AJ  This revision was skipped due to integration of internal documentation
 Changes in the test system for including new product.
AI
1.2.0.8
15/08/2017
 Changes the time of Burn In.
 Enhancements for reducing the threshold voltage of internal voltage
AH
1.2.0.8
17/02/2017
regulator.
 Enhancement in factory process.
AG  Changed the product label to comply with the new revision of CE 1.2.0.8
31/08/2016
directive.
 Homologation of alternative part numbers for components used on this
AF
1.2.0.8
07/06/2016
product.
AE  Improved the performance of the output update time.
1.2.0.8 28/10/2015
 Approval on EtherCAT Conformance Test.
AD
1.2.0.3
16/06/2014
 Included the support for operation with Xtorm Series.
AC  Included Graunding Clip Holder.
1.0.1.1
12/04/2013
AB  RoHS compliant revision.
1.0.1.1
14/02/2013
AA  Initial revision.
1.0.0.0
24/10/2012
2.20 BCS-NX2020 - 16 DO RELAY MODULE - BJ
REV Description
 Changes in the test system for including new product.
AJ
 Changes the time of Burn In.
 Enhancements for reducing the threshold voltage of internal voltage
AI
regulator.
AH  Enhancement in factory process.
Altus Sistemas de Automação S.A.

Version

Date

1.2.0.3

15/08/2017

1.2.0.3

17/02/2017

1.2.0.3

31/08/2016
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Changed the product label to comply with the new revision of CE
directive.
Homologation of alternative part numbers for components used on this
product.
Impovements in the Factory Test system.
Approval on EtherCAT Conformance Test.
Included the support for operation with Xtorm Series.
Included Graunding Clip Holder.
RoHS compliant revision.
Initial revision.

1.2.0.3

08/06/2016

1.2.0.3

07/06/2016

1.2.0.3

28/10/2015

1.2.0.3

23/06/2014

1.0.1.1
1.0.1.1
1.0.0.0

12/04/2013
14/02/2013
24/10/2012

Version

Date

1.2.0.9

22/03/2022

1.2.0.9

26/07/2021

1.2.0.9

24/06/2020

-

-

1.2.0.9

25/09/2017

1.2.0.9

05/10/2016

1.2.0.9

11/07/2016

1.2.0.9

13/05/2016

1.2.0.9

11/05/2016

1.2.0.9

27/01/2016

1.2.0.7

03/11/2015

1.2.0.5

03/12/2014

1.2.0.4

12/06/2014

1.0.1.5

13/03/2014

1.0.1.3

03/06/2013

1.0.1.1
1.0.1.1
1.0.0.13

12/04/2013
21/02/2013
24/10/2012

REV Description
Version
AP  Improved stability of power-on under specific conditions.
1.1.0.7
 Updated UL Mark adding cUL (Canada). Due to the process of
AO
introduction on production line, this update may be present in some 1.1.0.7
units before this revision.
AN  Included protectors for the product connectors.
1.1.0.7

Date
29/11/2021

AF
AE
AD
AC
AB
AA









2.21 BCS-NX6100 - 4 AO VOLTAGE/CURRENT MODULE - BJ
REV Description
 Minor improvement in the external mechanics of the product, without
AU
significant impact.
 Updated UL Mark adding cUL (Canada). Due to the process of
AT
introduction on production line, this update may be present in some
units before this revision.
 Updated the product label for compliance of the UL certification, File
AS
Number E496087.
 These revisions were skipped due to integration of internal
AO-AR
documentation
 This new product revision is related to modifications for including other
AN
module in test system.
 This new product revision is related the inclusion in news part numbers
AM
for internal codes with same electrical characteristics and with RoHS
compliance.
 Changed the product label to comply with the new revision of CE
AL
directive.
AK  Enhancement in factory process.
 Homologation of alternative part numbers for components used on this
AJ
product.
AI  Enhancements on hot swap.
 Enchancements on the calibration process of the module (performed
AH
during factory test).

 Enhancements on the calibration process of the analog channels
AG
(performed during factory test).
 Approval on EtherCAT Conformance Test.
AF
 Included the support for operation with Xtorm Series.
AE  Included the support for new hardware revision.
 Improvements on hot-swap logic.
AD  Improvements on module reconfiguration logic after a project
download.
AC  Changed the bill of materials to add the earthing sping holder.
AB  RoHS compliant revision.
AA  Initial revision.
2.22 BCS-NX4000 - BUS EXPANSION MODULE - BJ

Altus Sistemas de Automação S.A.

30/07/2021
24/09/2020
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Updated the product label for compliance of the UL certification, File
Number E496087.
These revisions were skipped due to integration of internal
documentation
Changed the product label to comply with the new revision of CE
directive.
Homologation of alternative part numbers for components used on this
product.
Improvements on module startup.
Approval on EtherCAT Conformance Test.
Included the support for operation with Xtorm Series.
Improvements on Factory Test system.
Improvements in the hardware revision.
Enhancement in the LCD test during start up.
Enhancement in the OTD function of the factory test.
Enhancement during start up of local diagnostics.
RoHS compliant revision.
Initial revision.

1.1.0.7

04/06/2020

-

-

1.1.0.7

31/08/2016

1.1.0.7

20/06/2016

1.1.0.7

25/01/2016

1.1.0.5

26/06/2014

1.1.0.2
1.1.0.2

11/11/2013
12/08/2013

1.1.0.2

09/07/2013

1.1.0.0
1.1.0.0

12/04/2013
21/02/2013

Version
1.0.17

Date
02/08/2022

1.0.17

30/07/2021

1.0.1.7

24/09/2020

1.0.1.7

04/06/2020

-

-

1.0.1.7

08/06/2016

1.0.1.7

07/06/2016

1.0.1.7
1.0.1.7
1.0.1.0
1.0.1.0

05/02/2016
16/06/2014
12/04/2013
28/01/2013

2.23 BCS-NX4010 - REDUNDANCY LINK MODULE - BJ
REV Description
AO  In this revision there were only internal changes in the documentation.
 Updated UL Mark adding cUL (Canada). Due to the process of
AN
introduction on production line, this update may be present in some
units before this revision.
AM  Included protectors for the product connectors.
 Updated the product label for compliance of the UL certification, File
AL
Number E496087.
 These revisions were skipped due to integration of internal
AG-AK
documentation
 Changed the product label to comply with the new revision of CE
AF
directive.
 Homologation of alternative part numbers for components used on this
AE
product.
AD  Enhancements on test software
AC  Approval on EtherCAT Conformance Test.
AB  Changed the bill of materials to include the ground spring holder.
AA  Initial revision.

2.24 BCS-NX9000 - 8-SLOT BACKPLANE RACK - BJ
REV Description
Version
 Updated UL Mark adding cUL (Canada). Due to the process of
AG
introduction on production line, this update may be present in some
NA
units before this revision.
AF  Included the Left/Right Side Rack Ends in the product structure.
NA
 Updated the product label for compliance of the UL certification, File
AE
NA
Number E496087
 This new product revision refers to the withdrawn of the Burn In step
AD
from the production process. In addition, the Left/Right Side Rack Ends
NA
has been removed from the product structure.
 Enhancements on factory test system to improve fault detection
AC
NA
coverage.
 Changed the product label to comply with the new revision of CE
AB
NA
directive.
AA  Initial revision.
NA
Altus Sistemas de Automação S.A.

Date
26/07/2021
11/11/2020
06/02/2018
26/06/2017
01/08/2016
13/06/2016
31/07/2015
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2.25 BCS-NX9001 - 12-SLOT BACKPLANE RACK - BJ
REV Description
Version
 Updated UL Mark adding cUL (Canada). Due to the process of
AR
introduction on production line, this update may be present in some
NA
units before this revision.
AQ  Included the Left/Right Side Rack Ends in the product structure.
NA
 These revisions were skipped due to integration of internal
AK-AP
documentation
 Updated the product label for compliance of the UL certification, File
AJ
NA
Number E496087
 This new product revision refers to the withdrawn of the Burn In step
AI
from the production process. In addition, the Left/Right Side Rack Ends
NA
has been removed from the product structure.
 Enhancements on factory test system to improve fault detection
AH
NA
coverage.
 Changed the product label to comply with the new revision of CE
AG
NA
directive.
AF  Enhancement in factory process.
NA
AE  Impovements on the package (included a plastic bag).
NA
AD  Impovements on the Factory Test system.
NA
 Impovements on the package.
AC
NA
 RoHS compliant revision.
AB  Label printed using a new printer.
NA
AA  Initial revision.
NA

Date
26/07/2021
11/11/2020
06/02/2018
26/06/2017
01/08/2016
13/06/2016
23/03/2016
09/12/2014
22/01/2014
14/03/2013
30/10/2012
21/08/2012

2.26 BCS-NX9002 - 16-SLOT BACKPLANE RACK - BJ
REV Description
Version
 Updated UL Mark adding cUL (Canada). Due to the process of
AT
introduction on production line, this update may be present in some
NA
units before this revision.
AS  Included the Left/Right Side Rack Ends in the product structure
NA
 Updated the product label for compliance of the UL certification, File
AR
NA
Number E496087
 These revisions were skipped due to integration of internal
AI-AQ
documentation
 This new product revision refers to the withdrawn of the Burn In step
AH
from the production process. In addition, the Left/Right Side Rack Ends
NA
has been removed from the product structure.
 Enhancements on factory test system to improve fault detection
AG
NA
coverage.
 Changed the product label to comply with the new revision of CE
AF
NA
directive.
AE 
Enhancement in document of the subassembly.
NA
AD  Impovements on the package (included a plastic bag).
NA
AC  Impovements on the Factory Test system.
NA
 Impovements on the package.
AB
NA
 RoHS compliant revision.
AA  Initial revision.
NA

Date
30/07/2021
11/11/2020
04/06/2020
26/06/2017
01/08/2016
02/07/2016
23/03/2016
09/12/2014
22/01/2014
14/03/2013
24/10/2012

2.27 BCS-NX9003 - 24-SLOT BACKPLANE RACK - BJ
REV Description
Version
 Updated UL Mark adding cUL (Canada). Due to the process of
AT
introduction on production line, this update may be present in some
NA
units before this revision.
Altus Sistemas de Automação S.A.

Date
03/08/2021
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Included the Left/Right Side Rack Ends in the product structure.
These revisions were skipped due to integration of internal
documentation
Updated the product label for compliance of the UL certification, File
Number E496087
This new product revision refers to the withdrawn of the Burn In step
from the production process. In addition, the Left/Right Side Rack Ends
has been removed from the product structure.
Enhancements on factory test system to improve fault detection
coverage.
Changed the product label to comply with the new revision of CE
directive.
Enhancement in document of the subassembly.
Impovements on the package (included a plastic bag).
Impovements on the Factory Test system.
Impovements on the package.
RoHS compliant revision.
Initial revision.




AH
AG
AF
AE
AD
AC
AB
AA

Date(dd/mm/yyyy): 15/12/2022










NA

11/11/2020

-

-

NA

17/04/2018

NA

26/06/2017

NA

01/08/2016

NA

05/07/2016

NA
NA
NA

23/03/2016
09/12/2014
22/02/2014

NA

26/04/2013

NA

24/10/2012

2.28 BCS-NX9010 - 8-SLOT BACKPL. RACK (NO HOTSWAP)-BJ
REV Description
Version

Updated UL Mark adding cUL (Canada). Due to the process of
AF
introduction on production line, this update may be present in some
NA
units before this revision.
AE 
Included the Left/Right Side Rack Ends in the product structure.
NA

Updated the product label for compliance of the UL certification, File
AD
NA
Number E496087

This new product revision refers to the withdrawn of the steps of Burn
AC
NA
In and Coating from the production process.

Changed the product label to comply with the new revision of CE
AB
NA
directive.
AA  Initial revision.
NA

Date
02/08/2021
11/11/2020
06/02/2018
26/06/2017
17/11/2016
31/07/2015

2.29 BCS–NX9020 – 2-SLOT MOUNTING PANEL - BJ
REV

Description

Version

Date

AB



Integration of internal documentation.

NA

29/05/2019

AA



Initial revision.

NA

10/07/2018

2.30 BCS-NX9100 - LEFT/RIGHT SIDE RACK ENDS – BJ
REV Description
Version
 Updated UL Mark adding cUL (Canada). Due to the process of
AE
introduction on production line, this update may be present in some
NA
units before this revision.
AD  This revision was skipped due to integration of internal documentation
 Updated the product label for compliance of the UL certification, File
AC
Number E496087
NA
 Simplification of the production process
 Changed the product label to comply with the new revision of CE
AB
NA
directive.
AA  Initial revision.
NA

Altus Sistemas de Automação S.A.

Date
11/08/2021
26/03/2018
05/07/2016
15/03/2013
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2.31 BCS-NX9101 - 32GB MICROSDHC WITH MINISD ADAP – BJ
REV Description
Version
AC  Changed from 8GB to 32GB
NA
 Updating of the documentation of the packaging procedure, which
changed the internal code of the label used.
AB
NA
 Updating of the product label for compliance of the new version of the
CE standard.
AA  Initial revision.
NA

Date
21/11/2018
23/01/2018
21/11/2013

2.32 BCS-NX9102 - BACKPLANE CONNECTOR COVER - BJ
REV Description
Version
 Updated UL Mark adding cUL (Canada). Due to the process of
AJ
introduction on production line, this update may be present in some
NA
units before this revision.
AI  This revision was skipped due to integration of internal documentation
 Updated the product label for compliance of the UL certification, File
AH
NA
Number E496087.
 These revisions were skipped due to integration of internal
AE-AG
documentation
 Updating of the documentation of the packaging procedure, which
AD
NA
changed the internal code of the label used.
 Changed the product label to comply with the new revision of CE
AC
NA
directive.
AB  Changed color of the packet label to gray.
NA
AA  Initial revision.
NA

Date
26/07/2021
23/01/2019
23/01/2018
13/06/2016
06/08/2013
31/10/2012

2.33 BCS-NX9401 - 6-TERMINAL CONNECTOR – BJ
REV Description
Version
 Updated UL Mark adding cUL (Canada). Due to the process of
AD
introduction on production line, this update may be present in some
NA
units before this revision.
AC  This revision was skipped due to integration of internal documentation.
 Updating of the product label for compliance of the new version of the
CE standard.
AB
NA
 Updating of the documentation of the packaging procedure, which
changed the internal code of the label used.
AA  Initial revision.
NA

Date
11/08/2021
10/01/2018
21/11/2013

2.34 BCS-NX9402 - 10-TERM. CONNECTOR WIRE HOLDER – BJ
REV Description
Version
 Updating of the product label for compliance of the new version of the
CE standard.
AB
NA
 Updating of the documentation of the packaging procedure, which
changed the internal code of the label used.
AA  Initial revision.
NA

Date
11/01/2018
05/08/2013

2.35 BCS-NX9403 - 20-TERM. CONNECTOR WIRE HOLDER – BJ
REV Description
Version
 Updated UL Mark adding cUL (Canada). Due to the process of
AD
introduction on production line, this update may be present in some
NA
units before this revision.
Altus Sistemas de Automação S.A.

Date
11/08/2021
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This revision was skipped due to integration of internal documentation.
Updating of the product label for compliance of the new version of the
CE standard.
Updating of the documentation of the packaging procedure, which
changed the internal code of the label used.
Initial revision.

-

-

NA

10/01/2018

NA

05/08/2013

2.36 BCS-NX9404 - 06-TERM.CONNECTOR SCREW FIXING - BJ
REV Description
Version
 Updated UL Mark adding cUL (Canada). Due to the process of
AE
introduction on production line, this update may be present in some
NA
units before this revision.
AD  This revision was skipped due to integration of internal documentation.
 Updating of the documentation of the packaging procedure, which
AC
NA
changed the internal code of the label used.
 Changed the product label to comply with the new revision of CE
AB
NA
directive.
AA  Initial revision.
NA

Date
11/08/2021
23/01/2018
05/07/2016
05/06/2014

2.37 BCS–NX9405 – 12-TERMINAL CONNECTOR SCREW FIXING - BJ
REV
AA

Description


Initial revision.

Version

Date

NA

17/07/2018

Version

Date

NA

17/07/2018

2.38 BCS–NX9406 – 18-TERMINAL CONNECTOR SCREW FIXING - BJ
REV
AA

Description


Initial revision.

2.39 BCS-NX5001 - PROFIBUS DP MASTER MODULE - BJ
REV Description
Version
 Updated UL Mark adding cUL (Canada). Due to the process of
AZ
introduction on production line, this update may be present in some
1.3.0.6
units before this revision.
 Fixed a problem where the diagnostic that informs the slave presence
AY
(abySlv_State[x]) could not indicate correctly the absence of the slave
1.3.0.6
on the network when the project has a large number of slaves.
AX  Included protectors for the product connectors.
1.3.0.5
AW  Updated the internal code of the flash memory of the product.
1.3.0.5
AV  PROFIBUS Certification.
1.3.0.5
 These revisions were skipped due to integration of internal
AK-AU
documentation.
 Updated the product label for compliance of the UL certification, File
AJ
Number E496087.
1.3.0.2
 Change in the product overlay to fix the opening of the display window.
AI  Changed burn-in time performed on manufacutring process.
1.3.0.2
 Changed the product label to comply with the new revision of CE
AH
1.3.0.2
directive.
 Homologation of alternative part numbers for components used on this
AG
1.3.0.2
product.
AF  Included the support for Scan for Devices feature.
1.3.0.2
AE  Included the support for DPV1 commands: Read Request and Write
1.2.0.6
Altus Sistemas de Automação S.A.

Date
30/07/2021

16/11/2020
24/09/2020
19/07/2019
01/07/2019
11/06/2018
10/05/2017
22/09/2016
20/06/2016
15/01/2016
22/07/2015
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Request.
Included the support to synchronize input data and output-data of DPSlaves (Global Control Commands: Freeze/Unfreeze/Sync/Unsync).
Included the support to new Project Profile called “Machine Profile”.
Enhancements on configuration process of NX5001 during the startup.
Approval on EtherCAT Conformance Test.
RoHS compliant revison.
Initial revision.

1.1.1.4
1.1.1.1
1.1.0.16

13/06/2014
31/01/2013
24/10/2012

2.40 BCS-NX5000 - ETHERNET MODULE - BJ
REV Description
Version
 Updated UL Mark adding cUL (Canada). Due to the process of
AS
introduction on production line, this update may be present in some 1.3.0.2
units before this revision.
AR  Included protectors for the product connectors.
1.3.0.2
 Updated the product label for compliance of the UL certification, File
AQ
Number E496087.
1.3.0.2
 Updated the internal code of the flash memory of the product.
 These revisions were skipped due to integration of internal
AJ - AP
documentation.
AI  Changed burn-in time performed on manufacutring process.
1.3.0.2
 Changed the product label to comply with the new revision of CE
AH
1.2.0.3
directive.
 Homologation of alternative part numbers for components used on this
AG
1.2.0.3
product.
 Fixed a compatiblity issue of NIC Teaming functionality with the
AF
1.2.0.3
Ethernet module of AL Series model AL-3414.
AE  Added support to project profile “Machine Profile”.
1.2.0.1
AD  Approval on EtherCAT Conformance Test.
1.0.1.4
AB  RoHS compliant revision.
1.0.1.1
AA  Initial revision.
1.0.0.10

Date
30/07/2021
24/09/2020
19/07/2019
05/10/2017
22/09/2016
20/06/2016
25/01/2016
23/07/2015
12/06/2014
31/01/2013
24/10/2012

2.41 BCS-NX5110 - PROFIBUS DP HEAD - BJ
REV Description
Version
 New format of firmware update file. This update requires the controller
running on firmware version 1.9.29.0 or greater.
 Added protection against CSRF (cross-site request forgery) for
AV
management pages in web interface.
1.2.0.0
 Updated UL Mark adding cUL (Canada). Due to the process of
introduction on production line, this update may be present in some
units before this revision.
 Changed firmware update mechanism to include support for the new file
1.1.2.12
format that will be introduced on upcoming versions.
 Removed the hidden page “getlogs” from the system web page to
AU
1.1.2.10
improve cyber security.
AT  Included protectors for the product connectors.
1.1.2.8
 Fixed a problem introduced on previous version related to diagnostic
AS
1.1.2.8
indication.
AR  PROFIBUS Certification.
1.1.2.7
 Included support for Nexto Safety modules.
AQ  Updated the product label for compliance of the UL certification, File 1.1.2.5
Number E496087.
 These revisions were skipped due to integration of internal
AN-AP
documentation.
AM  Changed burn-in time performed on manufacutring process.
1.1.1.16
Altus Sistemas de Automação S.A.
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26/07/2021
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12/02/2019
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Date(dd/mm/yyyy): 15/12/2022

Homologation of alternative part numbers for components used on this
product.
Enhancements in performance of the modules hot-swap circuit.
New revision of the PCB due to increase the power supply’s
performance (hot swap when in redundant mode).
Changed the product label to comply with the new revision of CE
directive.
Homologation of alternative part numbers for components used on this
product.
Included support for Nexto Jet solution for modules BCS-NJ1001, BCSNJ2001, BCS-NJ6000, BCS-NJ6010, BCS-NJ6020 and BCS-NJ6100.
Fixed a compatibility issue with PROFIBUS Master from AL Series
AL-3406
Included support for Scan Devices feature.
Included support for NX9010 rack.
Enhancements on the safe state of analog output channels.
Enhancements on configuration process of I/O modules during the
startup.
Included support for NX9999 e NX9000.
Initial revision.

1.1.1.16

11/01/2017

1.1.1.16

13/12/2016

1.1.1.16

06/09/2016

1.1.1.16

25/05/2016

1.1.1.16

15/01/2016

1.1.0.6

15/09/2015

1.0.0.25

06/05/2015

1.0.0.15

29/01/2015

1.0.0.12
1.0.0.0

15/12/2014
10/10/2014

2.42 BCS-NX5210 – REDUNDANT PROFIBUS DP HEAD - BJ
REV Description
Version
 New format of firmware update file. This update requires the controller
running on firmware version 1.9.29.0 or greater.
 Added protection against CSRF (cross-site request forgery) for
AR
management pages in web interface.
1.2.0.0
 Updated UL Mark adding cUL (Canada). Due to the process of
introduction on production line, this update may be present in some
units before this revision.
 Changed firmware update mechanism to include support for the new file
1.1.2.12
format that will be introduced on upcoming versions.
 Removed the hidden page “getlogs” from the system web page to
AQ
1.1.2.10
improve cyber security.
AP  Included protectors for the product connectors.
1.1.2.8
 Fixed a problem introduced on previous version related to diagnostic
AO
1.1.2.8
indication.
AN  PROFIBUS Certification.
1.1.2.7
 Included support for Nexto Safety modules.
 Updated the product label for compliance of the UL certification, File
AM
1.1.2.5
Number E496087.
 Change in the product overlay to fix the opening of the display window.
 These revisions were skipped due to integration of internal
AK-AL
documentation.
AJ  Changed burn-in time performed on manufacutring process.
1.1.1.16
 Homologation of alternative part numbers for components used on this
AI
1.1.1.16
product.
AH  Enhancements in performance of the modules hot-swap circuit.
1.1.1.16
 Changed the product label to comply with the new revision of CE
AG
1.1.1.16
directive.
 Homologation of alternative part numbers for components used on this
AF
1.1.1.16
product.
 Included support for Nexto Jet solution for modules BCS-NJ1001, BCSNJ2001, BCS-NJ6000, BCS-NJ6010, BCS-NJ6020 and BCS-NJ6100.
AE  Fixed a compatibility issue with PROFIBUS Master from AL Series
1.1.1.16
AL-3406
 Enhancements on the redundancy feature.
Altus Sistemas de Automação S.A.

Date

26/07/2021

26/07/2021
13/01/2021
24/09/2020
01/07/2019
08/04/2019
12/01/2019

05/10/2017
11/01/2017
13/12/2016
23/09/2016
25/05/2016

15/01/2016
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Included support for Scan Devices feature.
Included support for NX9010 rack.
Enhancements on the safe state of analog output channels.
Enhancements on configuration process of I/O modules during the
startup.
Enhancements to the network redundancy algorithm.
Initial revision.

AB
AA

Date(dd/mm/yyyy): 15/12/2022




1.1.0.6

15/09/2015

1.0.0.25

06/05/2015

1.0.0.15

29/01/2015

1.0.0.12

15/12/2014

2.43 BCS-NX5100 – MODBUS TCP HEAD – BJ
REV


AK



AJ



AI




AH



AG
AF





AE

AD

AC

AA-AB 

Descrição
Support for BCS Tools 3.40.
Fixed possible issue where the Web Page turns unaccesible after using
it for a very long time.
Fixed potential exception when an application is removed (reset
origin).
Minor improvement in the production process.
Change of the product label, which now includes a QR Code with the
path to the Technical Documentation of the product on the website.
This change makes it unnecessary to follow the Installation Guide
with the product.
UKCA Certification marking included on product.
New format of firmware update file. This update requires the
controller running on firmware version 1.9.29.0 or greater.
Added protection against CSRF (cross-site request forgery) for
management pages in web interface.
Updated UL Mark adding cUL (Canada). Due to the process of
introduction on production line, this update may be present in some
units before this revision.
Changed firmware update mechanism to include support for the new
file format that will be introduced on upcoming versions.
Improvements in “one touch diag” feature.
Removed the hidden page “getlogs” from the system web page to
improve cyber security.
Fixed a problem related to the system webpage cache. This eliminates
the need of clearing the cache on browser side, which was previously
required under some circumstances to show the page correctly.
Included protectors for the product connectors.
Fixed maximum number of ARTI/OPC DA connections from 4 to 8.
Changes in the source code shared with other controllers, which
doesn’t affect the behaviour of this product.
This revision was skipped due to integration of internal documentation
Oficial revision after conclusion of the development.
Initial revision.

Version

Date

1.12.5.3

15/12/2022

1.11.2.0

28/11/2022

1.11.2.0

26/07/2021

1.9.29.0

26/07/2021

1.9.25.0

13/01/2021

1.8.11.0
1.8.11.0

24/09/2020
09/01/2020

1.7.17.0

11/03/2019

1.0.0.5
1.0.0.1

29/06/2017
09/05/2017

2.44 BCS-NX5101 – MODBUS TCP HEAD, 14 DI, 10 DOT (NO HOTSWAP) - BJ
REV


AG


AF



Descrição
Version
Support for BCS Tools 3.40.
Fixed possible issue where the Web Page turns unaccesible after using
it for a very long time.
1.12.5.3
Fixed potential exception when an application is removed (reset
origin).
New format of firmware update file. This update requires the
controller running on firmware version 1.9.29.0 or greater.
1.11.2.0
Added protection against CSRF (cross-site request forgery) for
management pages in web interface.

Altus Sistemas de Automação S.A.
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15/12/2022

26/07/2021
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Date(dd/mm/yyyy): 15/12/2022

Changed firmware update mechanism to include support for the new
file format that will be introduced on upcoming versions.
1.9.29.0
Improvements in “one touch diag” feature.
Removed the hidden page “getlogs” from the system web page to
improve cyber security.
Fixed a problem related to the system webpage cache. This eliminates 1.9.25.0
the need of clearing the cache on browser side, which was previously
required under some circumstances to show the page correctly.
Included support for visualization of the integrated I/O by LCD (menu
Hardware).
Fixed “wrong slot” problem related to the usage of the NX9020 rack.
1.9.8.0
Fixed the problem where the Web page don’t update its elements
properly.
Included protectors for the product connectors.
1.7.9.0
Changed bootloader from version 1.0.0.13 to 1.0.0.14 due to code
sharing with CPU, but with no functional modification on this product 1.7.9.0
since it dont have RS-485 interface.
Initial revision.
1.7.9.0

26/07/2021

13/01/2021

09/11/2020

24/09/2020
06/11/2019
04/02/2019

2.45 BCS–NJ1001 – 24 VDC 16 DI MODULE NEXTO JET - BJ
REV
AL
AK
AG-AJ

AF

AE
AD
AC
AB
AA













Description
UKCA Certification marking included on product.
Minor improvement in the external mechanics of the product, without
significant impact.
These Reviews were ignored due to the integration of internal
documentation
Inclusion of the Installation Guide in the product BOM.
Updated UL Mark adding cUL (Canada). Due to the process of
introduction on production line, this update may be present in some
units before this revision.E496087
Changes in the test system for including new product.
Changes the time of Burn In.
Enhancement in factory process.
Changed the product label to comply with the new revision of CE
directive.
Homologation of alternative part numbers for components used on this
product.
Initial revision.

Version
1.2.0.20

Date
14/10/2022

1.2.0.20

16/11/21

-

-

1.2.0.20

17/05/2018

1.2.0.20

15/08/2017

1.2.0.20

31/08/2016

1.2.0.20

06/06/2016

1.2.0.20

19/05/2016

1.2.0.20

16/10/2015

Version

Date

1.2.0.7

22/03/2022

1.2.0.7
1.2.0.7

15/05/2020
15/08/2017

2.46 BCS–NJ1005 – 24 VDC 8 DOT/8 DI MIXED MODULE NEXTO JET - BJ
REV
AC
AB
AA





Description
Minor improvement in the external mechanics of the product, without
significant impact.
Integration of internal documentation.
Initial revision.

2.47 BCS–NJ2001 – 24 VDC 16 DO TRANSISTOR MODULE NEXTO JET -BJ
REV
AK
AH-AJ
AG





Description
Version
Minor improvement in the external mechanics of the product, without
1.2.0.8
significant impact.
These revisions were skipped due to integration of internal
documentation.
Inclusion of the Installation Guide in the product BOM.
1.2.0.8

Altus Sistemas de Automação S.A.
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Date(dd/mm/yyyy): 15/12/2022

Updated UL Mark adding cUL (Canada). Due to the process of
introduction on production line, this update may be present in some
units before this revision.E496087
Changes in the test system for including new product.
Changes the time of Burn In.
This new review of the product is related to improvements in the
production process. Due to the inclusion of universal pallets in the
assembly.
Enhancement in factory process.
Changed the product label to comply with the new revision of CE
directive.
Homologation of alternative part numbers for components used on this
product.
Initial revision.

1.2.0.8

15/08/2017

1.2.0.8

17/10/2016

1.2.0.8

31/08/2016

1.2.0.8

06/06/2016

1.2.0.8

19/05/2016

1.2.0.8

16/10/2015

Version

Date

1.4.0.0

16/12/2021

1.4.0.0

29/07/2021

1.4.0.0

06/05/2020

1.4.0.0

03/09/2019

1.3.0.7

06/12/2018

1.3.0.7

15/02/2018

1.3.0.3

15/09/2017

1.3.0.3

10/08/2016

1.3.0.1

31/05/2016

1.3.0.1

13/05/2016

1.3.0.1

11/05/2016

1.3.0.1
1.3.0.1

16/11/2015
24/09/2015

Description
Minor improvement in the external mechanics of the product, without
significant impact.
Enhancement in factory process.
Included support for 4-20 scale and for the new parameter “Open
Circuit Value”.
These revisions were skipped due to integration of internal
documentation.

Version

Date

1.1.0.1

22/03/2022

1.1.0.1

15/05/2020

1.1.0.1

03/09/2019

-

-

Initial revision.

1.0.0.14

08/05/2018

2.48 BCS–NJ6000 – 8 AI VOLTAGE/CURRENT MODULE NEXTO JET – BJ
REV
AM




AL
AK
AJ
AI

AH

AG
AF
AE
AD
AC
AB
AA
















Description
Minor improvement in the external mechanics of the product, without
significant impact.
Updated UL Mark adding cUL (Canada). Due to the process of
introduction on production line, this update may be present in some
units before this revision.
Enhancement in factory process.
Included support for the new option “Disabled” for the parameter
“Open Loop Value”.
Small text correction on Installation Guide
Enhancements of diagnostics detection of analog inputs.
Enhancements in detection of loss of bus master.
Inclusion of the Installation Guide in the product BOM.
Updated the product label for compliance of the UL certification, File
Number E496087.
This new product revision is related to modifications for including
other module in test system.
Enhancements on immunity against electromagnetic interference.
Changed the product label to comply with the new revision of CE
directive.
Enhancement in factory process.
Homologation of alternative part numbers for components used on this
product.
Hardware enhancements.
Initial revision.

2.49 BCS-NJ6001 – 6 AI V/I MODULE NEXTO JET 12 BITS – BJ
REV
AG
AF
AE
AB-AD
AA







Altus Sistemas de Automação S.A.
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2.50 BCS–NJ6005 – 6 AI/4 AO V/I MIXED MODULE NEXTO JET – BJ
REV
AM




AL
AK
AJ
AB-AI
AA






Description
Version
Minor improvement in the external mechanics of the product, without
1.1.0.1
significant impact.
Updated UL Mark adding cUL (Canada). Due to the process of
introduction on production line, this update may be present in some
1.1.0.1
units before this revision.
Enhancement in factory process.
1.1.0.1
Included support for 4-20 scale and for the new parameter “Open
1.1.0.1
Circuit Value”.
These revisions were skipped due to integration of internal
documentation.
Initial revision.

Date
22/03/2022
30/07/2021
15/05/2020
03/09/2019
-

1.0.0.14

08/05/2018

Version
1.0.0.16

Date
26/10/2022

1.0.0.14

22/03/2022

1.0.0.14

30/07/2021

1.0.0.14

15/05/2020

1.0.0.14

17/05/2018

1.0.0.13

15/09/2017

1.0.0.11

10/08/2016

1.0.0.9

08/07/2016

1.0.0.6

20/05/2016

1.0.0.6

13/05/2016

1.0.0.6

11/05/2016

1.0.0.6
1.0.0.6

30/11/2015
25/09/2015

Description
Enhancements on immunity against electromagnetic interference.

Version
1.0.0.16

Date
26/10/2022



Minor improvement in the external mechanics of the product, without
significant impact.

1.0.0.14

22/03/2022



Enhancement in factory process.

1.0.0.14

15/05/2020



These revisions were skipped due to integration of internal
documentation.

-

-



Initial revision.

1.0.0.14

08/05/2018

2.51 BCS–NJ6010 – 8 AI THERMOCOUPLE MODULE NEXTO JET – BJ
REV
AM
AL
AK
AJ

AI

AH
AG
AF
AE
AD
AC
AB
AA

Description
Enhancements on immunity against electromagnetic interference.
Minor improvement in the external mechanics of the product, without
significant impact.
 Updated UL Mark adding cUL (Canada). Due to the process of
introduction on production line, this update may be present in some
units before this revision.
 Enhancement in factory process.
 Change in the firmware source code to add a new module (BCSNJ6011) on compilation scope.
 Inclusion of the Installation Guide in the product BOM.
 Updated the product label for compliance of the UL certification, File
Number E496087
 This new product revision is related to modifications for including
other module in test system.
 Additional enhancements on immunity against electromagnetic
interference.
 Enhancements on immunity against electromagnetic interference.
 Changed the product label to comply with the new revision of CE
directive.
 Enhancement in factory process.
 Homologation of alternative part numbers for components used on this
product.
 Hardware enhancements.
 Initial revision.



2.52 BCS–NJ6011 – MIXED ANALOG MODULE NEXTO JET – BJ
REV
AF
AE
AD
AB-AC
AA



Altus Sistemas de Automação S.A.
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2.53 BCS–NJ6020 – 8 AI RTD MODULE NEXTO JET – BJ
REV

AL
AK
AJ
AI
AH
AG
AF
AE
AD
AC
AB
AA















Description
Updated UL Mark adding cUL (Canada). Due to the process of
introduction on production line, this update may be present in some
units before this revision.
Support for the new hardware revision which introduces additional
improvements to immunity against electromagnetic interferences.
Integration of internal documentation.
Small text correction on Installation Guide
Updated the product label for compliance of the UL certification, File
Number E496087.
This revision was skipped due to integration of internal
documentation.
Inclusion of the Installation Guide in the product BOM.
Changes in the test system for including new product.
Changes the time of Burn In.
Improved immunity against electromagnetic interferences.
Changed the product label to comply with the new revision of CE
directive.
Homologation of alternative part numbers for components used on this
product.
Hardware enhancements.
Initial revision.

Version

Date

1.1.0.8

29/07/2021

1.1.0.8

29/09/2020

1.1.0.3

24/06/2020

1.1.0.3

06/12/2018

-

-

1.1.0.3

17/05/2018

1.1.0.3

15/09/2017

1.1.0.3

13/01/2017

1.1.0.1

11/07/2016

1.1.0.1

18/05/2016

1.1.0.1
1.1.0.1

29/01/2016
31/07/2015

2.54 BCS–NJ6100 – 4 AO VOLTAGE/CURRENT MODULE NEXTO JET – BJ
REV
AM




AL
AK
AJ
AI
AH









AG
AF
AE
AD
AC
AB
AA








Description
Version
Minor improvement in the external mechanics of the product, without
1.2.0.9
significant impact.
Updated UL Mark adding cUL (Canada). Due to the process of
introduction on production line, this update may be present in some 1.2.0.9
units before this revision.
Enhancement in factory process.
1.2.0.9
Small text correction on Installation Guide
1.2.0.9
Inclusion of the Installation Guide in the product BOM.
Updated the product label for compliance of the UL certification, File 1.2.0.9
Number E496087.
Changes in the test system for including new product.
1.2.0.9
Changes the time of Burn In.
This new product revision is related the inclusion in news part
numbers for internal codes with same electrical characteristics and
1.2.0.9
with RoHS compliance.
Changed the product label to comply with the new revision of CE
1.2.0.9
directive.
Enhancement in factory process.
1.2.0.9
Homologation of alternative part numbers for components used on this
1.2.0.9
product.
Internal firmware modifications, with no impact on product
1.2.0.9
functionalities.
Hardware enhancements.
1.2.0.7
Initial revision.
1.2.0.7

Date
22/03/2022
26/07/2021
15/05/2020
10/12/2018
17/05/2018
15/09/2017
05/10/2016
22/07/2016
13/05/2016
11/05/2016
27/01/2016
20/11/2015
13/07/2015

2.55 BCS–NJ6101 – 4 AO V/I MODULE NEXTO JET 12 BITS – BJ
REV
Altus Sistemas de Automação S.A.

Description

Version

Date
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Minor improvement in the external mechanics of the product, without
significant impact.
Enhancement in factory process.
Included support for 4-20 scale.
These revisions were skipped due to integration of internal
documentation.

1.1.0.1

22/03/2022

1.1.0.1
1.1.0.1

15/05/2020
03/09/2019

-

-

1.0.0.14

08/05//2018

Scope

Version

Date

GSD

1.0.1.4

08/12/2015

GSD

1.0.0.0

10/09/2015

Initial revision.

2.56 GSD Files - PROFIBUS DP HEAD NX OEM
REV
AB




AA



Description
Included new scales for NX6000 and NX6020 modules.
Included the file ALNJ0EDD.GSD, with support for the
I/O Modules of Nexto Jet solution.
Initial revision.

3. BCS Tools Series
3.1 BCS-MT8500/ADV – BCS-MT8500/LITE
MT8500/BASIC – BCS-MT8500/BIG

-

BCS-MT8500/PRO

-

REV Description
 Added support to new CPU NX3008.
 Added verification to check for the presence of non-related variables
inside redundant areas.
 Added Reset Origin Device Command.
 Added support to EtherCAT Master for all Nexto Xpress.
 Added LibIntegratedIoExt which allows to use additional analog inputs
on Nexto Xpress.
 Added a compilation error message when user uses REFERENCE TO
in persistent vars.
 Fixed Online Change performance, which was degraded since version
3.31.
 Fixed login performance when several CFC POUs windows were
opened.
 Fixed an issue where mappings of MODBUS Symbol Client and Master
could stop to work (frozen values) after an online change.
 Fixed an issue where graphical elements could show a red “X” ending
AX
on a crash due to GDI handle leak.
 Fixed an issue where deleting unused symbols on Symbol Configuration
could lead to exception on OPC UA Server.
 Fixed an issue where changing the execution order of CFC POU with
online change could lead to a PLC exception.
 Fixed BCS Tools crash error after closing ModBus Server window
when opening a project without updating it.
 Fixed an issue where changing focus in and out on NET fields results on
project change.
 Fixed BCS Tools crash error when changing Watchdog of MainTask on
Xpress controller.
 Fixed an issue where Project Compare could show differences for
identical CFC POUs.
 Fixed declaring the libraries dependencies as placeholders.
 Increased the maximum size of Program Memory from 2MB to 3MB on
XP300/XP315/XP325.
 Increased the maximum size of Program Memory from 6MB to 8MB on
Altus Sistemas de Automação S.A.
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Version

Date

3.40
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AW


















Date(dd/mm/yyyy): 15/12/2022

XP340 and NX3005.
Removed limit of 500 assemblies on EtherNetIP Scanner.
Updated version of EtherCAT Master driver.
Updated LibNextoPID library containing new standard and advanced
control functions.
General improvements on Portuguese and English texts.
Changed the minimum required firmware for PIOs Targets.
Added minimum required firmware check routine in the X2/BoX2/PIO
targets.
Added new message box to notify user if a new version is available for
download.
Added rules to allow adding only PLC compatible devices.
Added new command Create POUs from Template.
Added new PIO targets:
 PIO GL-9973.
 PIO GL-9974.
 PIO GL-9975.
Added new wizard features:
 Combo box to categorize devices during project creation.
 Fieldbus wizard configuration (protocol + slave + amount of
slaves).
Added start and stop system events in project template.
MODBUS Symbol:
 Fixed MODBUS Client/Server does not support ambiguous
variables.
 Fixed bug that IntegratedIO Tags don’t work with Modbus.
 Fixed exception in the PLC when changing the size of the array
mapped in MODBUS.
Project Update:
 New User Interface.
 Correct version displaying.
 Removed Project Environment window.
 Added LAN port name update for Ethernet and EtherCAT devices
when upgrading projects created in previous versions to HMI X2.
 Fixed behavior that caused the project to break when updating
without saving first.
 Fixed invalid version format error when updating X2 devices with
Ethercat Slaves.
Reduced CPU consumption when logged in.
Fixed window behavior not closing during code generation.
Fixed wizard behavior not correctly displaying ethernet interface
choices.
Fixed Modbus TCP Slave configuration tabs that were not displayed.
Fixed exception when loss connection to the PLC.
Fixed compilation error when using J1939 ECU device in projects with
X2 modules.
Fixed Gateway conflict message with other Gateways already installed.
Fixed incorrect channel and description texts in Integrated I/O page.
Fixed keyboard shortcuts S and N for Write and Force dialogs in
Portuguese language.
Fixed improper add of GVLs IoQualities and Modules_Diagnostic when
opening project created on previous versions.
Fixed issue that allows Maintask interval greater than 100 ms in projects
with Machine Profile.
Fixed missing .DLL that causes problemas in Trace object of previous
versions.
Removed the ‘Enable retain and persistent variables in function blocks’
checkbox from CPU parameters page.
Removed ‘Scan for Devices’ command for PROFIBUS devices.
Removed software license update window during startup.
Removed access to startup application settings.
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Date(dd/mm/yyyy): 15/12/2022

Added new target PIO GL-9972.
Added new Ethernet/IP adapter GN-9089.
Added new PROFINET Device GL-9087.
Added new PROFINET Device GN-9287.
Added CSV import and export tab of I/O mappings.
Fixed issue in MODBUS Symbol RTU Master that makes mappings
stop to work after an online change.
Fixed issue in MODBUS Symbol RTU Slave that makes mappings stop
to work after an online change.
Fixed crash after closing the Clock Settings dialog.
Fixed application startup exception when declaring arrays of function
blocks in retain or persistent areas.
Fixed system out of memory error caused by changes in Redundancy
configuration.
Fixed J1939 device issue regarding stack version.
Fixed issue that made impossible to delete the copies of UserPrg POU.
Fixed the startup with invalid international settings.
Fixed issue in PID Control editor that causes malfunction after
performing a ‘clean all’ command.
Created “OPC UA” device category
Unchecked, by default, the ‘Recipe management in the PLC’ option in
the ‘Recipe Manager’ object.
Renamed bit bReserved05 to bHardwareFailure for Ponto series module
PO1213.
Updated BFI inverters devices.
Updated Ethernet/IP GN-9289 device.
Updated G-Series Modules and PIO targets.
Improved the project template for PIO Beijer devices.
Improved the project template for X2/BoX2 Beijer devices.
Improvements in NX5000 redundancy performance.
Improvements in Portuguese translation.
Fixed improper online change request due to IoDrvNextoRedundancy
library.
Fixed improper online change request due to LibDatabaseManager
library.
Fixed the overlap of I/O addresses for PROFINET devices.
Improvements in PROFIBUS diagnostics for Ponto Series slaves.
Added new target GL-9971 (PIO).
Added OPC UA for GN-937x (PIO).
Added ‘Declarations > Add all instance paths’ command for
PersistentVars.
Added confirmation dialog for force variables command (F7).
Added confirmation dialog for write variables command (Ctrl + F7).
Added ‘Connected Clients’ counter in the status bar (requires
compatible firmware).
Added support to System Events.
Added support to reStructuredText documentation for libraries.
Added Application tab on target device.
Added ‘Scan for Devices’ feature for all Beijer devices.
Added ‘Disable Device’ command present in the Devices tab.
Added the default configuration ‘Auto-reconnect’ on the Modbus TCP
Master device for GN-9372 and GL-9971.
Fixed compatibility with projects created between versions 3.15 and
3.23.
Fixed issue in MODBUS Symbol Server that makes mappings stop to
work after an online change.
Fixed issue in MODBUS Symbol Client that makes mappings stop to
work after an online change.
Fixed issue that makes ‘subsequent’ attribute don’t be applied on online
change.
Fixed issue that makes new objects marked in Redundancy
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Configuration don’t be applied on online change.
Fixed Ethernet/IP Scanner to proper work with I/O bit mapping from
existing symbolic variables.
Fixed ‘Scan for Devices’ command of EtherCAT Master on online
mode.
Fixed compile error for GVLs with attribute ‘qualified_only’ in
Redundancy Configuration.
Fixed improper download request for Nexto projects with EtherCAT
Master.
Fixed improper online change request for projects with CFC’s POUs.
Fixed behavior of pulse variables (Special_Variables GVL) for projects
with “Basic” profile.
Fixed issue that put project with Symbol Configuration in dirty state
after opening.
Fixed the installation conflict with Codesys 3.5 SP15 Patch 5.
Enabled ‘Download Application Info’ option for all targets.
Removed command “Tools > Import and Export Options”.
Improvements in Portuguese translation.
Improvements in online help (Nexto Xpress resolution of PT100 and
PT1000).
Improvements in CSV import and export commands.
Improvements in installer.
Improvements in PID Control editor.
Fixed auto-declare of variables for X2/BoX2 targets.
Changed the default values of the MODBUS TCP Master settings.
Changed the default values of the Ethernet Adapter settings.
Changed the default values of EtherCAT Master settings.
Updated the GN-9386 and GL-9086 EtherCAT slaves.
Improvements in PIO available application objects.
Improved the performance to save project changing the project
compress level from maximum compress to minimum compress.
Fixed the issue of the Gateway not starting.
Updated CANopen inverter devices.
Changed “Set all outputs to default” as standard on the “PLC Settings”
tab for GL-9971 and GN-9372.
Changed the default configuration ‘Enabled 1 (use bus cycle task if not
used in any task)’ on rack devices for GN-9372 and GL-9971.
Fixed the Special Variables program calls location in redundant
applications.
Added new targets X2, BoX2 and PIO;
Added command “License Manager” in “Tools” menu;
Added command “License Repository” in “Tools” menu;
Added command “Bookmarks” in “View” menu;
Added commands “Find in Project” and “Replace in Project” to
standard toolbar;
Added new default options for “SmartCoding” and “FBD, LD and IL
editor”;
Increased the RAM usage limit of the programming system for x64
architecture;
Increased maximum number of tasks of Nexto Xpress PLCs from 5 to
16;
Integrated I/O points are considered by Wizard when creating a project
with I/O modules;
Enabled on Menu “Declarations” the submenu “Reorder List and Clear
Gaps”.
Included new default options for “SmartCoding” and “FBD, LD and IL
editor”.
Improved mappings limit routines;
Improved project treeview display;
Improved robustness of Login command;
Improvements in “Update Software License” Window;
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Improvements in device treeview to show access modifiers;
Improvements in message texts about memory range field exceeding
PLC memory limit;
Improvements in portuguese message texts;
Improvements in project update (modify device) for products with
Integrated I/O;
Improvements in simulation mode;
Improvements in Wizard usability;
Improvements of color schemes in Text Editor options;
Improvements of the intelligent input assistance:
 Categories: Open with ‘Ctrl + Space’, switch pages with arrows
left/right;
 Filters: When typing elements from DUTs or FBs, naming filter
now is independent of character position and characteres are
highlighted;
Improvements on CFC ToolBox and Editor:
 Accelerated multiple insertion of an element from the ToolBox in
the CFC editor, by selecting the element on ToolBox view, pressing
Ctrl and left clicking in the editor to insert at each new click;
 Auto Dataflow Mode as new default setting;
 Display Execution Order shows the execution order of the blocks as
overlay;
 Execution order is setting is adaptable in POU properties;
 Explicit start point for feedback loops;
 Drag and drop of variables;
Improvements on ST Editor:
 When the cursor is on a symbol name, all occurrence locations of
the symbol within the editor are highlighted;
 Incremental search for strings with ‘Ctrl + Shift + i’;
 Navigation through searched string with ‘Alt + Page Up/Page
Down’;
 Comment and uncomment multiple lines at once via context menu
or ‘Ctrl + o’ and ‘Ctrl + i’ shortcuts;
 Editing columns via keyboard operation ‘Shift + Alt + Arrow Keys’;
 Auto declare via “Smart Tags” with suggestion popup. Keyboard
shortcut is ‘Ctrl + .’;
Improvements on Watch:
 Type cast for pointer inside Watch;
 Monitoring of instance via interface, also in case of dynamically
created objects;
 Monitoring of the instance when reference is made via pointer;
Removed IL language from Wizard;
Removed Spanish option from installer;
Removed the confirmation dialog before execute the commands Delete
and Cut;
Removed unsupported objects from X2 PLCs;
Signing of compiled libraries supported, and new icons. See more info
in ‘Library Manager > Icon legend’;
Updates the fieldbus devices;
Fixed CANOpen CiA 405 Library Help navigation;
Fixed error on printing the project through the command “Document…”
in “Project” menu;
Fixed Ethernet/IP Scanner’s configuration issues regarding import of
third-party EDS files;
Fixed improper online change request after close and reopen a project;
Fixed improper online change request due to Symbol Configuration
automatic cleanup routine;
Fixed improper online change request on projects with not installed
third-party devices;
Fixed improper variable uncheck after project update due to Symbol
Configuration automatic cleanup routine;
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Date(dd/mm/yyyy): 15/12/2022

Fixed installer issue that applied wrong file permissions during
reinstalling;
Fixed issue that hides product library when the project is
opened/created;
Fixed Wizard calculation of number of Thermocouple modules.
Added support to IEC 60870-5-104 Server protocol on XP340.
Added support to Client Certificate on MQTT Protocol.
Added diagnostics to new USB devices (Wifi and 3G/4G modem) on
Nexto Xpress.
Increased limit of OPC UA variables from 5000 to 20000.
Increased limit of Export Online Variables from 30000 to 60000.
Performance optimization of Export Online Variables routines.
Fixed bit forcing issues for direct mapped variables.
Fixed compilation error in Simulation Mode when using some CPU and
rack combinations.
Fixed compilation error caused by LibDatalogger dependencies.
New limit of 16000 Ethernet/IP Device assemblies for the whole
project.
Added support to Update Device context menu for EtherCAT Slaves.
Increased limit of assemblies per Ethernet/IP Device to 500.
Fixed an issue where a password-protected project would failed to open.
Fixed an issue where PIDControl object would not always save the
generated code correctly.
Fixed some issues with Export Online Variables.
Improved Project Update for update of children devices.
Improved support for multiple versions to be installed in parallel.
Improvements in texts for Portuguese and English Cultures.
Included MODBUS Symbol Client device version 1.0.0.25 for support
of old versions.
Added a new type of license: BIG Program Professional.
Increased limit of assemblies per Ethernet/IP Device from 50 to 60.
Fixed a crash in Ethernet/IP interface when configuring “AXL E EIP DI
16 M12 6P” device.
Improvements in Project Wizard.
Improvements in texts for Portuguese and English Cultures.
Added a new command called “Start PACTware” in “Tools” menu to
call an Asset Management Tool.
Fixed exception in Redundant NX3030 after project synchronization
process;
Fixed issue causing “Online Change” when opening project with
WebVisualization object.
Added option Refactoring in the menu Tools/Options;
Added new Module Options on EtherNet/IP Module of EtherNet/IP
Adapter: SInt Input Module x 124, SInt Output Module x 125, Int Input
Module x 124, Int Output Module x 125, DInt Input Module x 124, DInt
Output Module x 125, Real Input Module x 124 and Real Output
Module x 125;
Added support for MQTT_CLIENT Function Block (provided by
LibMQTT), which allows the controller to publish/subscribe MQTT
messages;
Added support for MSSQL_CLIENT Function Block (provided by
LibSQLClient), which allows the controller to connect to a Microsoft
SQL Server database;
Added support to CAN termination parameter on the CPU device for
XP300, XP315, XP325 and XP340;
Added network configuration rules in XP300, XP315, XP325 and
XP340 to prevent downloads with invalid configuration.
Improvements in Project Update;
Improvements in Project Wizard;
Improvements in the project file creation;
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Date(dd/mm/yyyy): 15/12/2022

Improvements in NX3003 Integrated/IO Mapping;
Improvements in texts for Portuguese Culture;
Disabled Expansion Ethernet Interfaces and Redundancy network for
Basic License;
Fixed a problem was removing the Redundancy Configuration object
while updating the project;
Fixed a problem generating code without errors with NX4000 modules
disconnected;
Fixed problem creating unnecessary NX4000 modules;
Fixed a crash in BCS Tools while updating some kind of redundant
projects;
Fixed a problem prevented project creation when BCS Tools
International Settings was marked “Same as Microsoft Windows”;
Fixed issue that caused “Online Change” when opening project in
specific situation;
Fixed a crash in Ethernet/IP interface when configuring “AXL E EIP DI
16 M12 6P” device.
Added support to XP340 PLC;
Added option on the device IEC 60870-5-104 Server to receive a
command in local time;
Added option to the device IEC 60870-5-104 Server to send timestamps
in local time;
Added the command Refactoring in the menu Edit;
Added new options of Baudrates for Nexto Xpress Serial (COM1): 2400
bps and 4800 bps;
Added new elements for Visualization feature;
Added a new object called Alarm Manager;
Added a new object called Trend Recording Manager;
Added a new object called Interface;
Added CANopen Manager for XP300 and XP315;
Added J1939 Manager and ECU for XP300, XP315, XP325 and XP340.
Improvements in Help Files;
Improvements in Import/Export CSV;
Improvements in International Settings;
Improvements in Project Update;
Improvements in Project Wizard;
Improvements in the project file creation;
Improvements in MODBUS Server Mapping Screen;
Improvements in Comparing Projects with PIDControl object;
Improvements in texts for Portuguese Culture;
Improvements in Fast Input configuration consistency;
Improvements in PLCOpenXML Import command;
Fixed SNTP period parameter in compiler warning to resolve “Implicit
conversion from unsigned Type ‘USINT’ to signed Type ‘SINT’” error;
Fixed problems to configure MODBUS in COM interfaces after
selecting Normal Mode;
Fixed a problem to send the project archive to PLC;
Fixed a problem to show Security Screen in the previous versions;
Fixed NX9020 description;
Fixed an error when saving Recipes using REAL variables;
Fixed call location at MainPrg of redundant applications;
Fixed login with online change in Redundant Project;
Fixed copy/paste for CANopen Remote Device;
Changed the MainTask Interval to be triggered as a warning, no longer
as an error for Xpress CPUs;
Changed field name of the serial advanced parameter to “RS-485
Termination”;
Changed download archive size from 16 MB to 26 MB for XP300,
XP315 and XP325;
Added support in MODBUS Symbol drivers and IEC 60870-5-104
Server driver to variables from Function Blocks with EXTENDS
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directive;
Added consistency when try to using a NX5100 with NX9020;
Disabled clock settings in simulation mode.
Included XP3xx in CANopen Slave Devices library (to be used with
CANopen Manager).
Improvements in Project Update;
Improvements in the project file creation;
Improvements in Help Files;
Fixes in copy and paste commands in I/O Mapping;
Fixes in Special Variables GVL.
Added Integrated I/O Mapping for NX3003 and XP3xx;
Enabled Protocol EtherNet/IP Scanner and Adapter for all CPUs;
Included Datalogger functionality (added LibDataLogger library);
Added a new system GVL called Special Variables including Pulsating
Bits, Clock variables and Constants;
Added new “Open Circuit Value” parameter for XP3xx Analog Inputs;
Added information about modules installation in Help files;
Added a tooltip that shows up in the configuration screen when passing
the mouse cursor above the modules;
Improvements in NX5101 Modbus Mappings to align data according to
the physical order;
Improvements in Analog Output Configuration Page XP315 and
XP325;
Fixed error message in New Project Screen when trying to add I/O
modules;
Improvements in the English culture help files;
Fixed I/O Simulation tool was not working for Integrated I/O in
NX3003, XP300, XP315 and XP325;
Limited the use of reserved words (“DigitalInputs”, “DigitalOutputs”,
“FastInputs” and “FastOutputs”) in code generation for CPU NX3003,
XP300, XP315 and XP325;
Fixed the incompatibility with NJ6001 and NJ6005 (introduced in
recent versions 3.14 and 3.15) when module have firmware version
lower than 1.1.0.1.
Updated the compiler to fix a potential occurrence of exception when
using Ethernet IP protocol.
Included option "disabled" for open circuit value on 4-20mA inputs of
NX6000 and NJ6000 modules, allowing reading of signals below 4mA
(0 to 4mA).
Included 4-20mA scale on modules NJ6001, NJ6005 and NJ6101,
adding also an option to set the behavior of analog inputs on open
circuit condition.
Added "Login" Button to Easy Connection.
Including a confirmation message before removing objects from the
project.
Added Right Click to open the product information web page in
Configuration (Bus).
Use Internet Explorer 11 to show the start web page (requires Internet
Explorer 11 to be installed).
Improvement to copy and paste on Modbus Symbol Server.
Improved algorithm of the LibNextoPID with anti-reset windup and the
automatic error recovery (ex: Gp < 0).
Fixed the translation of the "Paste Contacts" submenu in the "FBD / LD
/ IL" menu.
Fixed to always create a project with newest version of PLC.
Fixed possible error "Object reference not set to an instance of an
object" after request export to CSV.
Fixed the culture selection after open the "Clock Settings" dialog.
Fixed the "Export Online Variables" command.
Fixed error introduced on version 3.10 which may cause exception after
a switchover of redundant PLC.
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Fixed error introduced on version 3.11 which results on exception when
reading/writing to MODBUS mappings with variable size longer than
16 bits.
Changed limits of Recipe Manager, keeping only the limit of 5.000
variables per Recipe Definition.
Improved Help.
Changed the installer to solve some cases where the installation process
results on error when running on outdated versions of Windows 7 and
8.1.
Added CANopen Manager support for XP325.
Added Fast I/O support (counters, interrupts and PWM/PTO) for
XP300, XP315 and XP325.
Added Interruption option and Counter Interrupts to NX3003 in
Integrated I/O window.
Added support for Import and Export to NX3003, XP300, XP315 and
XP325.
Updated help with CANopen.
Fixed the checkbox “Enable retain and persistent variables in Function
Blocks”, which was not being effective when checked specifically for
Nexto Xpress controllers.
The declarations editors (GVL and POUS) now opens in tabular mode.
Added LibMachineOEM.
Automatically open the project update window for outdated projects.
Fixed a problem on PLC Redundancy control algorithm, which could
cause a failure on the switchover process if an specific communication
problem between the CPUs has occured previously.
Added I/O Simulator page
Added new hot swap mode “Hot Swap Disabled Without Startup
Consistency” for following devices: NX3003, NX3004, NX3005,
NX3010, NX3020, NX3030 and NX5100
Updated help
Added encryption to OPC UA
Opens the declarations editors (GVL and POUS) in tabular mode
Added a message box to warning about changing values when user
leaves a page
Improved the error message when use a Basic license
Added support to Nexto Xpress PLCs XP300, XP315 and XP325
Added support to NX3003 PLC
Added support to NX5101 MODBUS TCP Head
Added support to OPC UA configuration
Added EtherNet/IP Adapter
Added option in the project wizard to create the directory to project’s
files
Added “Find in Project” command in menu “Edit”
Added “Replace in Project” command in menu “Edit”
Added “Browse Call Tree” command in menu “Edit > Browse”
Added “BCS Tools Perspective” command in menu “View > Choose
Perspective”
Added “HMI Perspective” command in menu “View > Choose
Perspective”
Added “Visualization” command in menu “View > HMI Views”
Added “HMI Features” command in menu “View > HMI Views”
Added “Programmings” command in menu “View > HMI Views”
Added “Datasources” command in menu “View > HMI Views”
Added “Commit Accepted Changes” command in menu “Project”
Added “Insert Execute Box” command in menu “FBD/LD/IL”
Added “Add to Recipe Definition” command in context menu of the
POUs and GVLs
Added “Browse Call Tree” command in context menu of the POUs
Added “Export Library” command in context menu of the Library
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Manager
Included Encryption tab in the Application object
The parameter “Minimum Error Before Clock Update” accepts a new
range from 1 up to 65519 ms
Improvements in the performance of Import Safety Projects command
Improvements in the Import Safety Projects command
Added Help files for EtherNet/IP in Portuguese;
Included the possibility of enabling hot swap on CPU configuration,
even when using Nexto Jet modules (which doesn’t have support for
this feature). This allows to avoid stopping the PLC when a remote bus
expansion rack is disconnected.
Added Import Safety Project… and Delete Safety Objects Imported…
commands in Project menu;
Added message if no device was found when Easy Connection is
executed;
Added on the About dialog the version in wich the project was created;
Added support to Alarm Manager and Alarm Configuration;
Added support to NX9020 rack.
Increased the limit of the EtherCAT slaves to 192.
Added EtherNet/IP Scanner;
Added the IEC 60870-5-104 Server device;
Added Disable Breakpoint and Enable Breakpoint commands in Debug
menu;
Added Easy Connection command;
Added Edit IO mappings command in context menu of Device object;
Added new commands (Reorder list and clean gaps, Save current values
to recipe and Restore values from recipe) in Persistent Variables object;
Added NJ1005, NJ6001, NJ6011, NJ6101 and NX5100 modules
support;
Added options to Operating Mode command in Online menu;
Added Toggle Breakpoint command to POU when CPU is connected;
Added Placeholders command in context menu of Library Manager
object;
Added Print Preview command in File menu;
Added quality variables support for IO modules;
Added quality variables support for MODBUS Symbol Client driver;
Added Wink command in Source upload… and Source download…
commands;
Changed tab design for all screens;
Changed the Synchronism screen in CPU configuration. The new screen
allows time zone configuration with SNTP disable;
Created a new design option to Communication Settings screen;
Enable or disable redundant objects causes online change download;
Fixed a problem in compiler using Symbol Configuration and variables
with character “_”;
Fixed an issue in PersistenVars that initialized variables when a variable
type was changed during an online changes process;
Fixed problems with source download options;
Implemented a change to decrease the project archive size when
removing objects;
Implemented a change to show right quantity of recent projects in the
start page;
Implemented a consistency to deny read, write and force invalid indexes
of arrays;
Implemented a process to close all windows when a logoff is done;
Implemented Export/Import process for Dynamic IP address parameter
in NET1;
Implemented Export/Import to User and Groups of Project Settings
command;
Implemented new options tabs (Device description download, Library
download and Proxy Settings) in Options command in Tools menu;
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Implemented new tab Target memory settings in Application object;
Implemented new tab View in tab option CFC Editor in Options
command in Tools menu;
Implemented new warnings in tab Compile warnings of Project Settings
command;
Implemented Permission for Folders in the Permissions Window;
Implemented setting 'keep running on CPU stop' to MODBUS Slave
and Server
Implemented the consistency of maximum number of PROFIBUS slave
bytes;
Improvements in Auto Declare command;
Improvements in Breakpoints command;
Improvements in Cross Reference List command;
Improvements in EtherCAT Master Sync Window;
Improvements in GVL and PersistentVars objects;
Improvements in Help files;
Improvements in memory usage during project update;
Improvements in NX5001 tab DP-Parameters;
Improvements in online changes process in certain cases
Improvements in Portuguese Culture Screens;
Improvements in POU for implicit checks object;
Improvements in Project Information... command;
Improvements in Recipe Manager;
Improvements in Recipe object in Tree view;
Improvements in Symbol Configuration object;
Improvements in tab option Device Editor in Options command in
Tools menu;
Improvements in tab option SmartCoding in Options command in Tools
menu;
Improvements in Trace object;
Improvements in Watch command;
Included Internal Points configurations in Nexto CPUs;
Some difference project structure for new projects:
 Changed Wizard Page to choose the language of UserPrg and
StartPrg;
 New projects are created with four folders called SystemGVLs,
SytemPOUs, UserGVLs and UserPOUs;
 A new POU called StartPrg is created for every new project;
 A new POU called UserPrg is created for non-redundant projects;
 Three new GVLs called IOQualities, Module_Diagnostics and
System_Diagnostics are created;
 The Diagnostics GVL is not created for new projects;
Removed a wrong icon from Add Gateway Window.
Enabled Redundant PROFIBUS network for NX3020 in Wizard page;
Improvements in Redundant State Machine using only Ethernet I/Os;
Improvements to decrease the size of BCS Tools projects.
Added NX3005 CPU support;
Added the Visualization feature to the tool. This feature enable users to
create screens loaded and stored in the CPUs memory with the logic
application. Using this feature is possible access created screens trough
the web browsers. This feature is enable only for NX3005 CPU:
 Added Visualization Manager object used to set general
configuration of Visualization feature;
 Added WebVisualization object used to set the specific
configuration related with web access in the created screens;
 Added Visualization objects that is used to create screens to access
application information;
 Added Image Pool object to the application. This object is used to
create a list of images that can be used in the Visualization;
Added Network Variable List (NVL) feature to tool. The feature enable
exchanging variables among controllers trough the CPU network
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interfaces.
Added a new command called Clock Settings that is an easy way to get
and set date and time in the CPUs;
Added the option of Dynamic IP Address to the CPU Ethernet interface
(DHCP Protocol);
Added the option Edit Page Size in the CFC Menu;
Fixed a problem using Export to CSV feature and the SOE enabled;
Fixed a problem using Export Online Variables command;
Fixed a problem related with Symbols in Treeview with Redundant
PROIFBUS Networks;
Improvements performance in Import from CSV command.
Fixed an eventual issue with redundant system startup when using
exclusively PROFIBUS slaves from Nexto Series;
Changed verification rule of hot-swap mode parameter for Nexto Jet
Solution to allow the system to startup even with absent modules.
Changed the product label to comply with the new revision of CE
directive.
Added a new type of license: BIG PROGRAM;
Included a new option that allows to use Retain and Persistent variables
on Function Blocks;
Changed the verification rule of NX3004 maximum current to allow the
operation with up to 20W in some specific conditions;
Added support for NX9010 rack with NX5110;
Enhancements on Export Online Variables command;
Fixed import/export for projects with PO7078 module;
Compilation performance optimization in projects with MODBUS
Client and MODBUS Master;
Performance optimization on Open Project, Generate Code and Login
commands.
Added support for Nexto Jet solution, with the inclusion of the
following modules: NJ1001, NJ2001, NJ6000, NJ6010, NJ6020,
NJ6100.
Added a new PROFIBUS slave device called NX5110_NJ which allows
to use Nexto Jet solution modules with the Nexto Series PROFIBUS DP
head.
Added Export and Import Online Variables command in the Online
Menu.
Added support for flexibility of Persistent and Retain memory area
sizes.
Implemented support to use old Nexto modules with Machine Profile.
Enhancements on PIDControl when using it on redundant projects.
Changed name and description of parameter Allocate Diagnostic Area
According to the Device Description in NX5001 configuration.
Consistency of EtherCAT parameters Sync0 and Sync1.
Consistency of EtherCAT slave parameter Cycle Time.
Improvements in message texts about synchronization options for
EtherCAT configuration.
Improvements in help files about EtherCAT.
Removed the diagnostic HotStartCounter from the diagnostic structure
of NX3004 CPU.
Fixed errors using NX9010 in simulation mode.
Changed the text of hot swap options in CPU General Configuration
tab.
Improvements in Portuguese Help files.
Improvements in message texts about Modbus direct mapping limits.
New Features:
Added Scan Devices feature for Nexto Series PROFIBUS Master
NX5001;
Added NX9010 Rack support.
Enhancements:
Improvements in EtherCAT Master Device;
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Date(dd/mm/yyyy): 15/12/2022

Improvements in OPC Configuration Screen including new verifications
for ARRAY type and a new option to use CPU embedded gateway;
Improvements in OPC Server service;
Improvements in Symbol Configuration object to remove automatically
deleted variables;
Improvements in the treatment of GSD files from third part suppliers
into Device Repository;
Improvements in Force Command for bit type;
Improvements in Edit commands (Add/Copy/Paste/Cut/Delete) for
PROFIBUS Slave Devices;
Improvement in Wizard Page to treat current consumption before
creating a project;
Improvements in Help files.
New Features:
EtherCAT Master:
1. Added EtherCAT Master Device to be inserted as a communication
driver;
2. Enabled the option Scan Devices to scan automatically the devices
connected below the EtherCAT Master.
Added a new Project Profile called Machine Profile execute fast
applications.
Added Nexto Series PROFIBUS DP slaves NX5110 and NX5210:
1. Added Nexto Series PROFIBUS slaves into the Configuration and
Consumption;
2. Added Nexto Series PROFIBUS slaves into the Bill of Materials;
3. Added limits verifications for Nexto Series PROFIBUS Slaves.
Added NX3004 CPU support.
Added NX9000 Rack support.
Added SNTP support in the NX3010 CPU.
Added a library to read and write PROFIBUS DPV1 commands using
NX5001 interface.
Added a new configuration in the CPU screen called Enable I/O Update
per Task used to Update I/O in task different than MainTask.
Added Export and Import from PLCOpen XML in the Project Menu.
Added the option called Redundancy without panel to use a redundant
system without the Control Panel.
Automatically vital failure treatment for Ethernet interfaces and
MODBUS Client devices in Half Cluster redundancy Projects.
Enhancements:
Improvements in Portuguese Culture Screens;
Improvements in Portuguese Help files.
New Features:
OPC Server;
Added OPC Server into the installer;
Added OPC Configuration menu to configure devices to connect with
OPC Server;
Added Symbol Configuration object to define variables available for
OPC Server access;
Application CRC;
Added CPU Information menu to Access Project and CPU CRC;
Added a new Diagnostics for Nexto CPUs to access CRC.
Export to and Import from CSV Files:
Added support to Export and Import Nexto CPUs parameters;
Added support to Export and Import Nexto Series Modules
configuration;
Added support to Export and Import Ponto Series PROFIBUS Slaves;
Added support to Export and Import GVLs into CSV files;
Added support to Export and Import POUs in ST language;
Import through selection of multiple CSV files.
Recipe Manager:
Added Recipe Manager object;
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Date(dd/mm/yyyy): 15/12/2022

Added Recipe Definition object;
Added LibRecipeHandler to manage Recipes into the application;
Added a new programming language called CFC Page-Oriented
language and its editor;
Added Sync and Freeze commands support for NX5001.
Added two new hotswap modes for Nexto Series CPUs:
Disabled;
Enabled, with startup consistency.
Windows 8.1 support.
Enhancements:
Ponto Series PROFIBUS slaves;
Added Ponto Series PROFIBUS slaves into the Configuration and
Consumption;
Added a new screen to configure Ponto Series bases;
Added a new screen to configure Ponto Series expansion;
Added Ponto Series PROFIBUS slaves into the Bill of Materials;
Added limits verifications for Ponto Series PROFIBUS Slaves.
Project Wizard:
Added option to select bus expansion with redundancy;
Added option to select redundancy project with OPC communication;
Added a page to create IO modules during the wizard configuration;
Added Project Profile descriptions;
Help files improvements and optimizations;
Optimization in the Nexto Series graphical configuration;
Added PID_INT and PID_REAL Function Blocks into the
LibNextoPID;
Improvements in PIDControl Editor to edit main variables and retain
them values;
Blocked Project Update from new projects to older versions;
Changed contact support link URL;
Improved the consistencies for 24 characters in device identifiers;
Added a verification to prevent the use of "AT" in redundant objects;
Changed the behavior to create and download project archive with
online change;
Changed the behavior to create boot application implicit on download
and online changes;
Changed the option Source Download to “Prompt at program Download
and online Changes” by default;
Changed the Option additional files to send “Download information
files” by default;
Improvements in the usability of FBD/IL/LD editor;
Improvements in the usability of CFC editor.
New Features:
Implemented Edit Object (offline) command;
Disabled the option “Exclude from build” for CPUs;
Added a new analog I/O module: NX6020 – 8 AI RTD Module.
Enhancements:
Standardization in comments of modules parameters and in texts used in
Modbus mappings;
Improvements on saving memory card configuration;
Improvements in Import/Export commands;
Implemented, into the update command, the feature to update redundant
projects from any version without stops the application;
Removed the option to read Modbus data using broadcast slave address
because it was an invalid command;
Updated libraries to improve the accuracy of local bus watchdog
detection;
Fixed problems in Online Change using Modbus drivers;
Fixed a situation where MODBUS driver could incorrectly indicate
NX5000 failure;
All diagnostics structure library are now visible.
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Date(dd/mm/yyyy): 15/12/2022

New Features:
Changed the installer based in Microsoft InstallShield to installer based
in Inno Setup. This change reduces the installation time;
Added MODBUS devices with mappings of symbolic variables;
Added Import/Export command to CSV files. This command imports or
exports the project configurations;
Added Import/Export support to the MODBUS Symbolic drivers;
Added a new analog I/O module: NX6010 – 8 Ch. Thermocouple Input
Module;
Added LibLogs with new function block to manage CSV files into the
memory card.
Enhancements:
Improvement to receive MODBUS serial frames before 3.5 characters
silence.
Changed the MODBUS mappings limit from 128 to 512.
Changed the limit of characters of TAGs from 24 to 255.
Changed the limit of characters of Descriptions from 48 to 255.
Changed the limit of characters of Devices Names from 24 to 255.
Updated compiler version to 3.4.4.27.
Updated Libraries.
Updated Libraries.
Enhancements on performance.
Corrections in memory overlap verification for Diagnostics Variables.
Enhancements on Project Update.
Enhancements on Simulation Mode.
Added External Events configuration.
Correction in memory allocation of retain variables for online changes.
Initial revision.
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